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Overview

How to use these help files:

Welcome to iBiz! This manual is provided to assist you in finding your way around the iBiz 
application. Whether you are a first-time user just learning the ropes, or an iBiz expert hunting 
for power user tips, we trust that this guide will help you take advantage of everything iBiz has 
to offer. To get you started, here are a few notes about how to use the iBiz User’s Guide.

Browsing: To get a quick overview of what is contained in this manual, please visit the Table of 
Contents page and browse the chapter headings. Page numbers are included for quick refer-
ence. If your PDF viewer has a Bookmarks tab, you can also use this to easily jump between 
chapters.

Searching: If you have a particular question in mind, you can use the search function in your 
PDF viewer to locate the section of the manual that addresses it. The contents of this manual 
have been organized in question format to better help you find what you are looking for. 

Hyperlinks: Throughout the guide, you will find words or phrases that are highlighted in red. 
The color indicates that the word or phrase is a hyperlink. If you are reading the manual in PDF 
format, you can click any hyperlink to jump to another section for more information on that 
topic. These cross-references should help to ensure that you always find the right answers to 
your questions, no matter where you start your search.

Notes: Interspersed throughout the manual you will find boxes containing extra information 
about the topic at hand. They might offer caveats about certain features, explain in greater 
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detail how certain functions work, or provide extra tips for power users who want to get a little 
bit more out of iBank.

NOTE
 

Look for boxes like this one for hints, tips, and extra info. 

Menu commands: In this manual, you are often instructed to choose commands from the 
various menus provided in iBank. To simplify the menu hierarchy, we chose to use the ‘>’ 
character to denote each sub-menu or menu item. To illustrate, when you see “Choose Project 
> Show > Closed Projects,” this can be interpreted as “Go to the Project menu, then go to the 
Show submenu, then choose Closed Projects.”

About iBiz:

iBiz is a time-billing application that integrates with Apple’s  Address Book and 

 iCal.

It allows you to keep track of time and earnings for different projects, create reports, make 
customizable invoices to bill your clients, and track payments and balances on your work ac-
counts.
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iBiz is used by retailers, consultants, attorneys, architects, designers, small business owners, 
freelancers, and many others. One of the goals in designing iBiz was to make it as versatile as 
possible so that it could be used in many different ways.

System requirements:

iBiz 4 requires Mac OS X 10.5 or higher.
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What’s New in iBiz 4?

The best Mac app for billing and time-tracking just got better! For managing projects, tracking 
billable hours, creating invoices and viewing accounts at a glance, no other software offers the 
same features and ease of use. And for multi-user teams, iBiz Professional grows with your 
business - seamlessly.

Take a look at these new features:

User Interface Enhancements. A modified main window allows for better organization 
of to do’s, files and event logs, while many new changes create a more intuitive work-
space.

Overhauled iCal Synchronization. With a completely new iCal sync engine, iBiz 4 
takes a leap forward in management and scheduling of billing, projects, job events, to 
do lists, alarms and more.

Professionally Designed Templates. An all-new library of invoice templates with 
cleaner, clearer layouts allows for more professional-looking bills, statements and 
reports

Simple Backup and Restore. An ounce of prevention - now backup all of your iBiz 
data to a secure location with a simple command, and restore from a backup file just 
as easily.
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Faster Editing and Entry. A new pop-up inspector lets you quickly edit project infor-
mation, while simplified add and delete buttons organize projects and clients. 

Redesigned Billing Accounts. Track how much each client owes you, which clients are 
overdue, and when payments are due. Record payments and deposits, and send these 
to your iBank 3 accounts for more detailed analysis.

Statements. Complete statement history makes it easy to send an overview of all past 
billing activity. Users can now include fees and late charges too. 

Reminders. Never miss a payment again! Before an invoice is overdue, resend a copy 
to your client with a watermark to remind them to send payment on time. 

Animated Graphs. Powered by Core Animation, now you can view statistics about your 
work graphically, and at a glance, with dynamic charts. 

Client Groups. Organize your client list into groups (by category, active/inactive, and 
so on), and view client balances and overdue invoices at a glance. 

Document Monitor Menu. Automatically track the time you spend working in different 
applications and display the totals in a convenient menu. Easily allocate blocks of time 
to your iBiz projects via drag and drop.

http://www.iggsoftware.com/ibank/downloads.php#older
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Expense Tracking. Designate any job event as an expense with a single click, and 
subtotal these items separately on invoices and reports.

...and much more! Continue reading to learn about getting started with iBiz 4.
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How do I install iBiz?

To install iBiz:

Download the iBiz application from our website at: 1.	 http://www.iggsoftware.com/ibiz/
downloads.php. Be sure to choose the correct version (Stand-Alone or Pro) to suit your 
needs.

Look for “iBiz.dmg” on your Desktop or in your Downloads folder. Double-click this file to 2.	
mount the “iBiz” disk image on your Desktop.

The disk image should appear on your Desktop - it looks like an external drive icon with 3.	
the iBiz logo on it. Double-click the disk image to open it.

In the window that appears, you should see the iBiz application, a Read Me, and some other 4.	
files. Drag and drop the iBiz icon onto your Applications folder to copy the software to your 
computer. If you have a previous version of iBiz installed, allow the computer to replace the 
existing application.

http://www.iggsoftware.com/ibiz/downloads.php
http://www.iggsoftware.com/ibiz/downloads.php


10 Chapter 1: Getting Started

Close the disk image window, then drag both the “iBiz” disk image and “iBiz.dmg” from 5.	
your Desktop or Downloads folder to the Trash.

Open your Applications folder and drag “iBiz” onto your Dock to keep it there for easy ac-6.	
cess.

Click the iBiz icon on your Dock to launch the software.7.	

That should do it! iBiz should now be installed correctly on your computer.

Read on to learn about getting started with the iBiz Setup Assistant.
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How do I use the Setup Assistant?

When you launch iBiz 4 for the first time, you will be presented with the Setup Assistant win-
dow. The Setup Assistant is designed to walk you through the process of configuring iBiz the 
first time you use it. Any of the settings you choose during this process can be modified later 
on. To revisit the Setup Assistant at any time, choose Help > Show Setup Assistant.

Click “Begin Setup” to start the configuration process.
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Choosing a company identity

On this page, you will provide iBiz with some basic information about your company, to be 
used as default settings on your estimates, invoices, and statements. iBiz uses Address Book to 
maintain up-to-date information; you just need to tell it which card contains information about 
your company. Click the large index card on the left side of the window to select a contact 
from your Address Book.

Next, choose a company logo to be displayed on your estimates, invoices, and statements. 
Click the “Browse” button and select any image file you have saved on your computer.
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These settings can be changed at any time by choosing iBiz > Preferences and clicking the  

Invoices button. Click “Continue Setup” in the Setup Assistant to proceed.

Building your client list

On this page, you will begin putting together a list of the clients with whom you do business. 
The left side of the window displays all of the cards currently in your Address Book. Drag and 
drop client cards from the “Address Book” box into the “iBiz Clients” box on the right to add 
them to your iBiz client list. To remove clients from your list, click the small “x” button next to 
them in the “iBiz Clients” box.
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Type names into the search box in the “Address Book” section to quickly locate clients. The 
number to the left of the search box represents how many clients are currently being displayed 
from your Address Book.

If you need to add clients that are not already listed in your Address Book, you can do so after 
you are done with the Setup Assistant. Once you have finished choosing clients, click “Continue 
Setup” to proceed.

Choosing default rates & taxes

On this page, you will choose some basic billing options as follows:
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Rate:

Enter your desired billing rate in the box provided. This number represents the hourly fee that 
will be assigned to new job events you create: however, it is just a default and can always be 
modified for individual job events.

Taxes:

If standard tax rates apply to most of the work you perform, enter them here. iBiz allows up to 
two tax rates to be calculated for each job event you create. Enter each tax rate as a percent-
age together with a name to help you identify it. If you enter two tax rates and want the first 
tax to be added to your fees before calculating the second tax, check “Compound taxes.” The 
tax rates you enter here are considered defaults and will be applied to all new job events, but 
can be modified for any particular event.

Time:

You can choose to round your timed events to a specified number of minutes if desired (e.g., 
lawyers typically bill in 6-minute increments). Check “Automatically round time” and choose 
an increment to use this feature. Any time you stop a timer, iBiz will automatically round the 
recorded time to the nearest increment.

You also have the option of whether to display your time in standard format (01:02:03) or 
decimal format (1.03). To use decimal format, check “Show time as decimal.” iBiz will use this 
format on estimates, invoices, statements, and reports as well as in the program interface.
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Once you have chosen your rate, taxes, and time settings, click “Continue Setup” to proceed.

Enabling the Document Monitor

On this page, you will choose whether or not to enable the Document Monitor. The Document 
Monitor automatically tracks the time you spend using different applications on your Mac, then 
lets you apply the recorded time to your existing job events. A project manager, for instance, 
might use the Document Monitor to measure how much time she spends using Photoshop, 
Mail, and iBank, then assign the time logged to job events named “Marketing,” “Communica-
tions,” and “Budgeting,” respectively.
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Check “Turn Document Monitor on each time iBiz is launched” to have the Document Monitor 
automatically start tracking your activity whenever you open iBiz. If you do not have Universal 
Access enabled, the Setup Assistant will prompt you to turn it on. Universal Access must be 
enabled in order to use the Document Monitor and File Cabinet features in iBiz. Click “Open 
Universal Access” to open System Preferences to the appropriate pane. Check “Enable access 
for assistive devices,” then close System Preferences to continue. You can disable this feature 
at any time under the “Universal Access” pane in System Preferences.

Completing the setup process

Once you have finished configuring the Document Monitor, click the “Done” button. If you are 
upgrading from an earlier version, iBiz 4 will automatically import all of your clients, projects, 
job events, invoices, estimates, payments and templates from earlier versions of iBiz.

Note
	 iBiz 4 is not “backwards-compatible” with earlier versions of iBiz. Any projects 

created in iBiz 4 will not be usable if viewed in earlier versions of iBiz, and at-
tempting to load iBiz 4 data with an earlier version of iBiz may corrupt your data.

Once you complete the Setup Assistant, you will be prompted to purchase iBiz 4. If you are not 
ready to purchase yet, click “Demo” to run iBiz in trial mode. You will be limited to 10 days of 
unrestricted use of iBiz, after which the software will only run for 10 minutes at a time. The 
purchase box will appear each time you start iBiz until you purchase a registration code.
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How do I purchase and/or register iBiz?

NOTE
	 If you purchased and installed iBiz through the Mac App Store, the software does 

not need to be registered. The information below only applies to the version of 
iBiz that is available for download from the IGG Software website.

Each time you launch iBiz in trial mode, you will be prompted to purchase the full version.
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If you are not ready to purchase yet, click “Demo” to continue using iBiz in trial mode. You 
will be limited to 10 days of unrestricted use of iBiz, after which the software will only run for 
10 minutes at a time. The purchase box will appear each time you start iBiz until you order a 
license code.

Purchasing iBiz

If the purchase window is not already 
open, choose iBiz > License to open 
it, then click “Purchase Info” and 
“Continue Purchase.” Our secure online 
order form will appear:
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The top-right corner of the window will show you the license you are about to order. If you 
previously had a registered copy of iBiz 3 running on your computer, iBiz 4 should recognize 
this automatically and indicate that you are purchasing an upgrade license (at a discount!). If 
you are not a registered user of a previous version of iBiz, the order form will indicate that you 
are purchasing a full license.

In the space provided, enter your name, email address, and credit card information. Once you 
have verified that everything has been entered correctly, click “Purchase” to connect to our 
online store and submit your order (you must be connected to the Internet to complete this 
step). Once the order has been accepted, iBiz 4 will register itself automatically and cease to 
operate in trial mode. An alert will display your license code (it’s probably a good idea to write 
this down) and confirm that your order was processed successfully. You will also receive a 
confirmation email within 24 hours containing a receipt of your purchase and a copy of your 
license code. Be sure to print a copy of this email and file it away for safe keeping!

NOTE
	 If you prefer not to purchase iBiz directly through the software, if you have prob-

lems with the built-in order form, or if you wish to purchase iBiz together with 
our other software as part of a package deal, please visit our online order page: 
https://secure.iggsoftware.com/store/

https://secure.iggsoftware.com/store/


21Chapter 1: Getting Started

Registering iBiz with an existing license code

If you are reinstalling iBiz, or you obtained a registration code from our online order page, click 
“Enter License” in the purchase window (choose iBiz > License if you don’t see this window).

Enter your name, email address, and license code exactly as they appear in your confirmation 
email, paying attention to capitalization and other such details. If you have difficulty register-
ing, see What if iBiz doesn’t accept my code? in Chapter 10: Frequently Asked Questions. Upon 
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successful entry of your registration info, the program’s trial limitations will be disabled and 
you will no longer be pestered to buy at startup.

Verifying your registration

To review your registration information at any time, choose iBiz > Registration Info. A window 
will appear displaying your registered name, email address, and license code. If you do not see 
“Registration Info” in the iBiz menu, but instead see “License,” then your copy of iBiz has not 
yet been registered.

Changing your registration

If you need to change the registration code used for a particular installation of iBiz, see How do 
I change the code used to register iBiz? in Chapter 10: Frequently Asked Questions.
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How do I configure my company info?

iBiz maintains some basic informa-
tion about your company that is 
used as default settings on your 
estimates, invoices, and state-
ments. The first time you launched 
iBiz 4, the Setup Assistant walked 
you through the process of choos-
ing an Address Book card for your 
company identity and a logo for 
your templates.

If you need to change these details, 
you can do so at any time in iBiz 
Preferences.
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Changing your company identity

Choose iBiz > Preferences and click the  Invoices button. iBiz uses Address Book to 
maintain up-to-date information; you just need to tell it which card contains information about 
your company. Click the large index card at the top of the window to select the appropriate 
contact from your Address Book.

Changing your company logo

Choose iBiz > Preferences and click the  Invoices button. Click the “Browse” button and 
select any image file you have saved on your computer (or drag & drop an image file onto the 
image well). The image shown here will be used as the default logo on new estimates, invoices, 
and statements that you create.

NOTE
	 Changes made to your company identity will not affect your existing templates. 

In order to use the new company info and logo on estimates, invoices, and 
statements, you will need to create new templates. When the new templates are 
created, iBiz will automatically insert the updated company info and logo where 
appropriate.
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How do I use the main window?

When you launch iBiz, the main window appears automatically:

1

2

3

4

56
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The numbers on the image above correspond to the following program features:

Toolbar1.	 : This bar, along the top of the window, contains shortcuts to many program func-
tions, including the search box.

Client list2.	 : The individuals and companies for whom you work appear in this list. If a par-
ticular client owes you money or has any overdue invoices, a notice will appear below that 
client. Select a client to view projects, billing accounts, and other program features pertain-
ing to that client.

Project list3.	 : The work you perform for each client is organized into discrete projects, which 
are displayed in this list. The projects shown pertain to the client(s) you currently have 
selected; choose a project to view its associated job events below.

Job event list4.	 : Each item you bill for, regardless of whether you are charging an hourly 
fee, one-time charge, quantity-based rate, etc., is recorded in this list. The job events 
shown here pertain to the project you currently have selected above. Use the “Estimate” and 
“Work” tabs to enter job events for estimates and invoices, respectively.

Info pane5.	 : This pane is used to show additional information about the project or job event 
you currently have selected. Click one of the four buttons at the bottom of the info pane to 
choose whether to display To Do items, the File Cabinet, the workday pane, or timer logs.

Inspector6.	 : This editor pops up whenever you double-click on a client, project, job event, or 
billing item. Use the inspector to view and edit details about any of these items.

 TIP
	 Many of these window panes can be resized by clicking and dragging the dividers 

between them. The pop-up inspector can be moved by clicking and dragging its 
border, if necessary.
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In addition to the program features pictured above, there are three others worth pointing out: 

Billing accounts7.	 : Select a client and click the “Billing” tab to view this section, which is 
where you manage your clients’ account activities. Estimates, invoices, reminders, pay-
ments, and statements are all recorded here.

Reports8.	 : Select one or more clients and click the  Report button on the toolbar to ac-
cess the reports window, where you can get detailed information about the work you have 
recorded with iBiz.

Template editor9.	 : Click the  Templates button on the toolbar to access the template 
editor window, where you can modify the list of available templates for generating esti-
mates, invoices, statements, and reports (as well as edit the templates themselves).
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How do I customize the toolbar?

To customize the toolbar (located across the top of the main iBiz window) Control-click any-
where in the toolbar area and choose “Customize Toolbar” from the contextual menu. In the 
sheet that appears, drag and drop icons to add them or remove them from your toolbar, or re-
organize them as desired. You will also find options controlling how the buttons are displayed 
(icons, text, size, etc.). Click “Done” when you have finished customizing the toolbar.

You can show or hide the entire toolbar at any time by clicking the oval-shaped button  in 
the top right corner of the main iBiz window (this is standard for most Mac OS X applications).
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What do I need to know to get started with iBiz 
quickly?

Basic hierarchy

iBiz has a simple hierarchical relationship among clients, projects, the individual activities (job 
events) you perform, and billing activity:

•  Clients sit at the top of the hierarchy - these are the people or companies for which 
you perform work. For each client, there are projects and billing items.

•  Projects represent the tasks for which you are hired. For example, if you are a 
graphic designer, a project might be to make a print ad, or design a brochure.

•  Job events, in turn, are kept under each project - these are the individual 
tasks for which you bill your client and track non-billable aspects of the 
project.

•  Billing accounts are also maintained for each client - these are made up of the 
estimates, invoices, reminders, payments, and statements that you have sent 
to and received from the client. They represent all cash flow exchanges be-
tween you and the customer, including some items which might not affect the 
customer’s balance (like estimates or invoice reminders).

To illustrate this hierarchy, suppose you are hired to design a brochure for a real estate agen-
cy. The agency itself would be your client, designing the brochure would be your project, and 
some of your job events might be graphic design or concept development. When you generate 
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an invoice and subsequently receive payment from the client, those items are recorded in the 
client’s billing account. This is just one of the many ways in which iBiz can be used.

Client-centered billing

iBiz uses client-centered billing. This means that all cash flow for the work you do or payments 
you receive from a customer go through a client. For example, let’s say you have a customer 
that gives you a $500 deposit to work on a project making a new brochure for their travel 
company. This $500 would be entered under the appropriate client (as opposed to entering 
it as an item at the project level) as a payment. Then, say you have finished the brochure and 
you want to bill your client for all of the work you have done, you would make an invoice for 
the project and that $500 credit would be applied to the invoice. If you were to look under the 
“Billing” tab in iBiz for that client, you would see both the recorded payment and the invoice 
you sent to the client.

Typical workflow

Here is an example of a standard workflow in iBiz: although this example lays out a specific 
workflow, it is important to realize that many of the steps can be skipped or modified to fit 
your specific situation. Let’s assume you have your clients entered in iBiz and you’ve been 
hired to work on a project, so you’ve entered that project in iBiz as well. What’s next?

First, you would make an estimate of the work you are going to perform. You would do this 
by clicking the “Estimate” tab for the select project and then use the small plus button at the 
bottom of the window to add job events. Give these job events appropriate names, rates, and 
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estimated time to complete them. Once you’ve created what you feel to be a good estimate, 
click the small invoice button below the project list and choose a template to use to create the 
estimate.

Once you’ve delivered that to your customer, begin working on the project: click the “Work” 
tab and add the appropriate job events that represent the work you are doing. Once you’ve 
completed the project and all of your events have been added, click the invoice button below 
the project list to send the customer an invoice. After you press “Done” on the invoice preview 
window, the invoice will show up under this client when you select the “Billing” tab.

Now let’s say that your customer has been late in paying your bill and you want to send them 
a reminder. Select the “Billing” tab, select the invoice for which you want to send a reminder, 
then click the gear-shaped button and choose “Add Reminder for Selected Invoice.” In the win-
dow that appears, you can adjust the watermark that appears over the reminder. This reminder 
has no financial ramifications for the billing account in iBiz; it is strictly to remind your client 
that they need to pay you.

Once the client does send you a payment, enter it in the client’s billing account and, optionally, 
choose which specific invoices the payment corresponds to (this will cause those invoices to 
be marked as paid automatically). If your client at any time needs a statement from you to see 
which invoices you have sent and which payments you have received, you can click the + but-
ton in the billing list and choose “Add Statement.” In the window that appears, choose which 
invoices and payments you want to appear on the statement and, if desired, you can add a late 
fee. Choosing “Done” on the statement preview window will commit it and it will show up in the 
client’s billing account along with the invoices, payments, and other billing activities.
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Quick Start Guide

In addition to the information written in these help files, we also have a Quick Start Guide 
available to help you get acquainted with iBiz. You can download it from our website here: 
http://www.iggsoftware.com/ibiz/downloads.php#manuals

http://www.iggsoftware.com/ibiz/downloads.php#manuals
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How do I backup and restore my iBiz data?

To ensure that your data is protected in the event of a hard drive crash, program error, or 
other unexpected issue, we recommend that you backup your iBiz data regularly.

Backing up your data

To backup your iBiz data, simply click the  Backup button on the toolbar, or choose File 
> Backup. Choose a name for the backup file and a location in which to save it. Click “Save,” 
and your iBiz data will be compressed and saved to a file with a “.bizbackup” extension.

The backup includes:

Client•	 s and their related Address Book cards

Project•	 s, including To Do items and File Cabinet files

Job event•	 s and all associated information

Document Monito•	 r logs and quick timer events

Billin•	 g data, including estimates, invoices, reminders, statements, payments, and balances

Template•	 s for estimates, invoices, statements, and reports

Custom job event•	 s

The backup does not include:

Registratio•	 n details and license code

General program preferences, including •	 tax rates
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iCal calendars you have •	 synced with iBiz

NOTE
	 If you do not have a copy of your license code, you can submit a request to have it 

emailed to you using the “Lost License” form on our website: http://www.iggsoft-
ware.com/support.php

Restoring your data

To restore your iBiz data, choose File > Restore, and choose the iBiz backup (“.bizbackup”) 
file you want to restore. Check the “Restore client information to Address Book” option so that 
your client list is properly restored, and click “Open” to proceed. iBiz will warn you that all of 
your current iBiz data will be replaced, and that restoring from a backup is a permanent opera-
tion and cannot be undone. To complete the restoration, click “Restore.” After restoring your 
data, quit and relaunch iBiz in order to access all of the restored data.

 TIP
	 If your iBiz client list has not changed since the backup was made, but you have 

made changes to those clients’ cards in Address Book (and do not want to over-
write those changes), leave the “Restore client information to Address Book” 
option unchecked. iBiz will add missing clients back to your list, but will not make 
any other changes to your Address Book data.

http://www.iggsoftware.com/support
http://www.iggsoftware.com/support
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Manually backing up

If you would prefer to backup your iBiz data manually, copy the following files from your com-
puter to a secure location:

iBiz (stand-alone version):

/Users/yourUserName/Library/Application Support/IGG Software/iBiz/ (iBiz data files)•	

/Users/yourUserName/Library/Application Support/AddressBook/ (Address Book data)•	

/Users/yourUserName/Library/Calendars/ (iCal calendars)•	

/Users/yourUserName/Library/Preferences/com.iggsoftware.iBiz.plist (iBiz preferences and •	
registration)

 TIP
	 If you only want to backup a single project, you can quickly locate it by Control-

clicking the project in iBiz and choosing “Reveal In Finder” from the contextual 
menu. The project file will appear highlighted in the Finder.

iBiz Server:

/Users/yourUserName/Library/Application Support/IGG Software/iBiz/ (iBiz Server data •	
files)

/Users/yourUserName/Library/Application Support/AddressBook/ (Address Book data)•	

/Users/yourUserName/Library/Calendars/ (iCal calendars)•	

/Users/yourUserName/Library/Preferences/com.iggsoftware.iBizServer.plist (iBiz Server •	
preferences and registration)



36 Chapter 1: Getting Started

iBiz Client:

/Users/yourUserName/Library/Application Support/IGG Software/iBiz/ (iBiz Client data •	
files)

/Users/yourUserName/Library/Preferences/com.iggsoftware.iBizClient.plist (iBiz Client •	
preferences and registration)

NOTE
	 The majority of data in an iBiz network is stored directly on the computer run-

ning iBiz Server. Backing up iBiz Client is only needed to preserve data that is not 
stored on the server, such as iBiz Client registration, custom job events and to do 
items that are not shared with iBiz Server, or clients and projects that have been 
checked out from the server.
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What are clients all about?

The client list, displayed along the left-hand side of the main 
iBiz window, makes up the most basic component of iBiz. All 
of your projects, job events, invoices, estimates, payments, 
etc., are tracked on a per-client basis - after all, somebody 
needs to pay you for the work you do!

iBiz integrates with the Apple  Address Book, so that each 
iBiz client is associated with a contact card in Address Book. 
New clients can be created directly in iBiz, but editing them 
requires that you use the Address Book application.

Double-click on a client to view additional information using 
the pop-up inspector.

 
Organizing clients

Clients can be displayed using their personal names, company names, or both. To select how 
you want your clients to be listed, choose iBiz > Preferences, click the  Clients button, 
and choose your preferred option.

Clients can be sorted alphabetically by name or according to their status. To change the sort 
order, click the header at the top of the client list (or go to Client > Sort Clients) and choose 
your preferred sort order.



42 Chapter 2: Clients

You can also create folders to group your clients arbitrarily. See How do I organize my clients 
in groups? in this chapter for more information. To read about searching and filtering clients, 
see How do I search for a particular client or filter the client list?, also in this chapter.

About the “All Clients” item

The  All Clients item allows you to view all projects regardless of which clients they are as-
sociated with. Select this item to generate reports based on all of your clients. It also provides 
an easy way to check for “orphaned” projects (projects that are not associated with any client): 
select “All Clients” and then look for projects with no client listed in the “Client” column. To 
re-associate an orphaned project, click and drag it onto the client to which it belongs.

NOTE
	 If you are using iBiz Client and do not see the “All Clients” item, iBiz Server may 

have it disabled. Check “All Clients” in the main iBiz Server window to allow iBiz 
Client users to access it.



43Chapter 2: Clients

How do I add or delete clients?

The first step in using iBiz is adding clients for whom you work. It is important to note that iBiz 

integrates with Apple’s  Address Book application. After installing iBiz, you will find a new 
group in Address Book called “iBiz Clients.” iBiz uses this group to track the individuals in your 
client list; if you remove it, iBiz will automatically recreate it.

Adding clients

To add a client, click the  button at the bottom left corner of the main iBiz window and 
choose “Add Client” (or go to Client > Add New Client). A sheet will appear asking you to select 
a contact card from your Address Book:
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Use your groups to help you locate a particular contact, or type a name in the search box to 
show all matching cards. Select a card and click “Select Person” to add it to your iBiz client list.

If the client you want to add does not yet have a contact card in your Address Book, click “New 
Client.” A form will appear requesting some basic contact information for the new client. Enter 
as many details as possible, then click “OK.” iBiz will create a new Address Book card, put a 
copy of it in the “iBiz Clients” group, and add it to your iBiz client list.

Adding clients via Address Book

If you already have several of your clients stored in Address Book and don’t want to add them 
one-at-a-time, you can use Address Book to add them all at once. Launch Address Book, and 
drag and drop the desired contact cards onto the “iBiz Clients” group. Any clients that are 
added to this Address Book group will automatically show up in your iBiz client list.

Deleting clients

Clients can be deleted from iBiz by choosing Client > Delete Client. Deleting a client from 
iBiz will also remove its contact card from the “iBiz Clients” group in Address Book, but will 
not delete it from Address Book altogether. Manually removing a client from the “iBiz Clients” 
group in Address Book will not delete the client from iBiz - iBiz will simply replace the Address 
Book card.
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NOTE
	 Be careful - deleting a client will also delete all iBiz projects and billing informa-

tion associated with that client. You cannot use “Undo” to restore a deleted client. 



46 Chapter 2: Clients

How do I edit client information?

Clients’ contact information cannot be modified directly in iBiz; it must be edited using the 

 Address Book application.

To view contact info for a client: select the client and choose Client > Show Client in Ad-•	
dress Book.

To edit contact info for a client: select the client and choose Client > Edit Client in Address •	
Book.

You can also view the Address Book entry for a client by double-clicking it, then clicking the 
small  button that appears in the pop-up inspector. Address Book will open the contact card 
for the selected client. Click the “Edit” button at the bottom of the Address Book window and 
make whatever changes are necessary. When you are done, click the “Edit” button a second 
time to end your editing session, and quit Address Book. iBiz will automatically update itself to 
reflect the changes you made in Address Book.

 TIP
	 If you want to completely re-associate a client with a different Address Book con-

tact card, select the client and choose Client > Associate Client to Address Book 
Person. In the sheet that appears, choose the new Address Book card with which 
the client should be associated.
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How do I check the status of my clients?

iBiz conveys the status of your clients and their billing accounts using several indicators in the 
client list, as described here:

Status icons

iBiz displays different icons in the client list to indicate the following:

 Normal client. If the client has an image associated with its Address Book card, it will be 
displayed here instead.

 Client group. Click the small arrow to the left to reveal the clients inside.

 A timer is currently running in one or more of this client’s projects.

 This client has lost its association to  Address Book. See One of my clients is showing 
a question mark! How can I fix this? in Chapter 10: Frequently Asked Questions for more 
information.

Colored status text

Blue text: The client currently owes you money. The balance owed is displayed under the cli-
ent’s name.
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Red text: The client has overdue invoices and/or statements. The balance owed and number of 
overdue items are displayed under the client’s name.

Gray text: The client has a negative balance on his/her account (i.e. you owe the client work or 
a refund). The balance is displayed under the client’s name.

Pop-up inspector

Double-click on a client to view additional informa-
tion in the pop-up inspector.

The top part of the inspector shows contact infor-
mation from the client’s Address Book card, includ-
ing the client’s image, name, email address, and 
phone number. Click the small  button to the right 
of the client’s name to view his/her contact card in 
Address Book.

The bottom part of the inspector shows information 
regarding the client’s billing account:

Balance:•	  The amount of money currently owed by the client. Click the small  button to 
view the client’s billing account.

Overdue:•	  The amount owed for invoices and statements that are currently overdue.

Unbilled:•	  The total earnings in the client’s projects that have not yet been invoiced.
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Overdue invoices:•	  The number of invoices that are currently overdue. Click “Send Re-
minder” to draft a reminder for the first overdue invoice, or click the  button to view 
overdue items and reminders in the client’s billing account.

Open projects:•	  The number of projects that currently have their status set to “Open.” Click 
“Send Invoice” to draft an invoice for any unbilled job events in the first open project, or 
click the  button to view the client’s open projects.

Click “Done” to close the inspector and continue working.
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How do I organize my clients in groups?

Along with the ability to sort and filter the client list, iBiz allows you to create groups to or-
ganize your clients in a way that best suits your workflow. You may want to keep together 
multiple contacts for one company you work with, or perhaps you provide different services 
and want to group your clients according to the service they utilize. You might even use client 
groups to archive old clients for whom you no longer work. Flexibility is what client groups are 
all about.

Creating groups

To add a client group, click the  button at the bottom 
left corner of the main iBiz window and choose “Add Client 
Group.” iBiz will prompt you to enter a name for the group - 
type on in and click “OK” to proceed. The new group will 
appear in your client list.
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Adding and removing clients

To add clients to a group, simply drag & drop clients onto 
the  group icon. To view the clients inside a particular 
group, click the small disclosure triangle to the left side of 
the group icon. To remove clients from a group, drag & drop 
them out of the group to another place in the client list.

Renaming groups

To change the name assigned to a group, double-click it in the client list, or select it and 
choose Client > Rename Client Group. Enter a new name for the group and press ‘Return’ on 
your keyboard to save the changes.

Deleting groups

To delete a client group, select it in the client list and choose Client > Delete Client Group. 
iBiz will present you with a warning before deleting the group. Click “Delete” to complete the 
operation.
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NOTE
	 Be careful - deleting a client group will delete any clients inside of the group, 

including their associated projects and billing accounts. You cannot use “Undo” to 
restore a deleted client group.
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How do I search for a particular client or filter the 
client list?

Searching clients

To search for a client by name, use the search box above the 
client list, in the toolbar. Click the magnifying lens in the 
search box and select “Search Clients: Client Name.” Then 
type part of the client’s name into the search box. iBiz will 
automatically hide any clients that do not match your search. 
To exit the search and show all of your clients again, click the 
‘x’ button inside the search box.

Filtering clients

iBiz also provides several options for filtering your clients. To show only clients with open 
projects and/or outstanding balances on their billing accounts, choose Client > Show Active 
Clients. To show only clients with overdue invoices or outstanding balances, choose the cor-
responding “Show” items from the Client menu. Note that filtering out clients will not delete 
them from iBiz, only temporarily hide them from view. To remove the client filters and show all 
of your clients in the client list, choose Client > Show All Clients.





Chapter 3: Projects





57Chapter 3: Projects

What are projects all about?

After clients, projects are the next major component for tracking your work with iBiz. Projects 
in iBiz typically represent jobs for which you are hired. For example, if you are web designer 
you might have a client for whom you need to revitalize and redeploy a website, so you might 
name a project for that client “Website Revamp.”

If you or your business are not hired on a per-project basis, you can use projects to track 
the work that you do over discrete periods of time. In this scenario you would want to create 
a project for each time period, for example, you might want to name your projects “January 
Consulting,” “February Consulting,” etc. (or for whatever time period you want to track). You 
can then invoice those projects at the end of each time period.

Viewing the project list
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Show the project list by clicking the “Projects” tab at the top of the main window or choosing 
View > Show Projects. With this view selected, projects associated with the client(s) selected in 
the client list are visible in the top half of the main iBiz window. Selecting a project from this 
list will display that project’s corresponding job events in the lower half of the main iBiz win-
dow.

NOTE
	 Projects are displayed only for the client selected in the client list. Selecting multi-

ple clients will display their associated projects together; clicking the “All Clients” 
item will display all of your iBiz projects.

Each project remembers which tab (“Estimate” or “Work”) was last open; when the project is 
selected, it will automatically open the tab that was used last. Double-click any project in the 
list to view and edit information about it using the pop-up inspector.

Organizing the project list

Click the heading at the top of any column in the project list to sort your projects according to 
the information in that column. Clicking a second time will reverse the direction of the sort.

You can show or hide individual columns by checking and un-checking them in View > Project 
Columns. Columns can be resized by clicking and dragging the divider between two column 
headings. The order in which columns are displayed can be changed by clicking and dragging 
the column headings themselves. For a description of the information contained in each col-
umn, see How do I edit project status/information? in this chapter.
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Additional project features

iBiz has the ability to synchronize projects with iCal, so that you can enter job events in either 
program and keep the other up-to-date. Along with job events, projects also maintain To Do 
lists and File Cabinets, which you can use to keep track of external files associated with your 
work. Continue reading to learn more about these features.
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How do I add or delete projects?

Adding projects

To add a project to the project list, select the client for whom the work is to be performed, 
then choose Project > New Project, or click the  button at the bottom of the project list. 
Double-clicking on a blank space in your project list will also create a new project.

When you create a new project, the pop-up inspector will automatically appear to let you begin 
entering details for that project. New projects are automatically assigned numbers: see How do 
I edit project status/information? (next page) for more information about project numbering.

Deleting projects

To delete an existing project, click to select the project (or Command-click to select multiple 
projects), then choose Project > Delete Project. You can also click the  button at the bot-
tom of the project list, or type Command-Delete on your keyboard. A dialog box will appear 
asking you to confirm that you want to permanently delete the project and all of its associated 
job events. Click “Delete” to complete the operation. All job events, To Do items, and File Cabi-
net settings (not the original files) will be deleted along with the project.

 TIP
	 If you make a mistake and delete a project by accident, see How do I recover a 

deleted project? (in this chapter) for information about how to restore it to iBiz. 
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How do I edit project status/information?

Configuring projects

Each iBiz project has a number of options that can be configured using the pop-up inspector. 
Double-click any item in the project list to show the inspector and configure the following 
options:

 
Name:

Enter a descriptive name here to help you quickly identify 
the project.

No.:

Each project is automatically assigned a number when it is 
first created. By default, the number assigned is one digit 
higher than the last project number entered. Feel free to 
change the number assigned to a project manually if neces-
sary; subsequent projects will follow in sequence from the 
number you type in.
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 TIP
	 To choose whether project numbers increment globally (across all clients) or 

separately for each client, choose iBiz > Preferences, click the  Advanced 
button, and select the desired option next to “Project numbers increment.”

Dates:

The “Start” date is used to track the date work began on the project. The “Due” date is used to 
track the date by which all work on the project must be completed. By default, this date is set 
to one month after the start date.

 TIP
	 A gray exclamation image  appears in the “Due Date” column of the project list 

when a project is past due and incomplete. 

Status:

The following status options are available for each project. Feel free to change a project’s sta-
tus anytime it is necessary, either by using the pop-up inspector or by clicking in the “Status” 
column of the project list.

Open:•	  Work is currently being performed on this project.

•	  Closed: All work has been completed and one or more invoices have been generated for 
this project. Click the  button to view the associated invoices.

On Hold:•	  No work is currently being performed; the project is temporarily suspended.
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Canceled:•	  No more work is to be performed for this project, and its earnings will not be 
billed.

NOTE
	 Generating an invoice for a project will automatically set its status to “Closed.” If 

you would prefer iBiz to leave your projects open after invoicing, choose iBiz > 
Preferences, click the  Advanced button, and check the “Leave projects open 
after invoicing” option.

Sync with iCal:

For information about configuring iCal synchronization, see How do I synchronize projects with 
iCal? in this chapter.

% Discount:

Check this option and enter a percentage to automatically discount all project earnings at that 
rate. For more information about discounts, see How do I apply a discount to a project? in this 
chapter.

Use fixed rate:

To specify a default billing rate for the project, check this option and enter the desired rate. 
Any new “Untitled” job events created for the project will be assigned the rate indicated. Exist-
ing job events will not be affected. Note that this option only sets a default rate; custom job 
events will still use their assigned rates, and individual job event rates can be changed manu-
ally after they have been created.
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Notes:

Use this space to record additional comments or information about the project.

Project columns

In addition to the user-configurable options just described, each project also displays the fol-
lowing information in the project list. These columns reflect information recorded by the proj-
ect’s corresponding job events and cannot be directly edited. Go to View > Project Columns to 
choose which columns are visible in the project list.

Client:•	  Displays the client with whom the project is associated.

Time:•	  Displays the total time of all work performed for the project. If a project contains 
quantity and/or mileage events in addition to timed events, the total quantity will be dis-
played in parentheses next to the total time.

Earnings:•	  Displays the total earnings of all work performed for the project. Non-billable 
job events, discounts, deductions, and taxes are not counted, but markups are.

Balance:•	  Displays the total unbilled earnings for the project. Invoiced job events, non-
billable job events, and taxes are not counted; markups, discounts, and deductions are (for 
unbilled events). If the balance is negative, it will appear in red.

Estimate: Displays the total estimated earnings for the project (see How do I create an invoice 
or estimate? in Chapter 5: Invoices & Estimates for more information on estimate events). A 
gray exclamation image  appears in the “Estimate” column when the project earnings have 
exceeded the estimate value.
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 TIP
	 A project’s status can be changed simply by clicking in the “Status” column. Some 

other project columns can be edited directly (without using the pop-up inspector) 
by holding down the Option key and double-clicking them.

Project totals

At the bottom right of the project list are two numbers separated by a slash. These represent 
the total balance and total earnings, respectively, of the displayed projects. Please note that 
these totals do not represent all projects associated with the selected client(s); the totals 
only reflect what is currently visible onscreen. Projects that have been filtered out will not be 
counted in these totals, likewise during a search only the displayed results will be tallied.

Other project-related information

Some additional project information is set using the info pane. See How do I use To Do items? 
and How do I use the File Cabinet? (in this chapter) to learn about these features.
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How do I synchronize projects with iCal?

Projects can be synchronized with iCal calendars instantaneously using Mac OS X Sync Services. 
This allows you to display any project’s job events in iCal for a simple workday, workweek, or 
timesheet-style view.

 TIP
	 Synchronizing a project, then using iCal to share the project’s calendar or publish 

it to a web page is an easy way to keep your clients up-to-date on the project’s 
progress.

Enabling synchronization

Create a calendar in iCal:1.	  First make sure you have a calendar set up in iCal that you 
would like to sync with your iBiz project. Each iBiz project should be synced to a unique iCal 
calendar, to avoid duplicating events between iBiz projects. Projects with start dates and 
due dates that do not overlap, however, can be synced to the same iCal calendar.

 TIP
	 To sync a large number of projects, create calendar groups in iCal for each of your 

clients. Store the calendars for each client in a separate folder; each calendar will 
sync properly, and they can be viewed all at once by selecting the group.

Choose a calendar in iBiz:2.	  Once you have an iCal calendar prepared, open iBiz and dou-
ble-click on the project you want to sync. In the pop-up inspector, click the double-arrows 
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to the right of “Calendar” and choose the calendar you prepared in step 1. If the calendar 
you want isn’t displayed, or if iBiz does not show any of your iCal calendars, choose Project 
> Sync with iCal > Refresh Calendars, and try again.

Choose the sync direction:3.	  Click the double-arrows to the right of “Direction” and choose 
an option for the current project:

Sync Both Ways:•	  Job events in iBiz and iCal will be kept in sync regardless of which 
program is used to create them.

Send Events to iCal:•	  iBiz is the primary point of data entry. Job events created and 
edited in iBiz are automatically synced to iCal, but any changes made in iCal are 
overwritten by those made in iBiz.

Get Events from iCal:•	  iCal is the primary point of data entry. Events created and 
edited in iCal are automatically synced to iBiz, but any changes made in iBiz are over-
written by those made in iCal.

Enable syncing:4.	  Check the “Sync with iCal” box to complete the setup process.

Initial sync options

The first time you enable synchronization between a project and an iCal calendar, iBiz will ask 
you to choose from the following “initial sync” options:
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Leave My Events Unchanged:•	  Any 
job events that currently exist in iBiz 
and iCal will be ignored.

Sync Both Ways:•	  All job events that 
currently exist in iBiz and iCal will be 
synced immediately.

Send Events to iCal:•	  Job events that 
currently exist in iBiz will be copied to 
iCal, but any other events in iCal will 
be ignored.

Get Events from iCal:•	  Events that 
currently exist in iCal will be copied to 
iBiz, but any other job events in iBiz 
will be ignored. 

NOTE
	 The option you choose here only applies to the first sync performed. Subsequent 

sync operations will use the setting you chose in step 3 above. Job events that are 
ignored by the initial sync will not be synced during subsequent sync operations 
unless changes are made to them (in which case iBiz will treat them as if they 
were newly entered).
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Syncing your data

Once your iBiz project has been linked to an iCal calendar, click the  Sync iCal button on 
the toolbar (or choose Project > Sync with iCal > Sync Now) to synchronize its events. If you 
prefer iBiz to synchronize your projects automatically whenever changes are made, check Proj-
ect > Sync with iCal > Automatically.

Each time you sync a project, the following operations are conducted:

Newly created •	 timed job events are copied between iBiz and iCal (other event types cannot 
be synced). Any iCal events that fall outside of your project dates will not be copied to iBiz. 
If a new job event is created in iBiz as the result of a sync, and its name matches one of 
your custom job events, iBiz will assign it the custom event details automatically.

Changes made to timed job events that were previously synced will be copied between iBiz •	
and iCal. Any iCal events that fall outside of your project dates will not have their changes 
copied to iBiz. When syncing in both directions, changes made in iBiz will take precedence 
over changes made in iCal (if you modify the same event with both programs before sync-
ing).

Deleted events are removed from iBiz and/or iCal. iBiz will warn you before deleting job •	
events as a result of a sync operation.

 TIP
	 To disable warnings before deleting job events as the result of a sync, choose iBiz 

> Preferences, click the  Workday button, and uncheck “Warn when deleting 
events from iCal sync.”
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To Do item•	 s are synced between iBiz and iCal (including new items, status changes, and 
deleted items).

NOTE
	 iBiz does not support repeating events like those available in iCal. Repeating iCal 

events can be synced to iBiz, but changes made to them in iBiz will only affect 
individual instances of the event when synced back to iCal - that is to say, iBiz 
won’t ask you whether you want to apply the changes to the rest of the repeated 
events. If you need to make a change to a repeating event and have it affect all 
subsequent events, that change needs to be made in iCal.

Disabling synchronization

To disable iCal syncing for a project, double-click on the project to show the pop-up inspector 
and uncheck “Sync with iCal.”

Troubleshooting

When a calendar is missing from the iBiz sync settings:

If you cannot find a particular iCal calendar listed in the pop-up inspector when you are con-
figuring synchronization, choose Project > Sync with iCal > Refresh Calendars, then try again.
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When an event won’t sync:

To force an individual job event to sync from iBiz to iCal, Control-click on the event and 
choose “Force Add to iCal on Next Sync.” The next time you click  Sync iCal or iBiz syncs 
automatically, you should see the event show up in iCal.

When a calendar is deleted from iCal:

If you accidentally delete an iCal calendar that was synced to an iBiz project, iBiz will simply 
change the “Calendar” setting in the pop-inspector to “No Value” and suspend syncing until 
you reconfigure the sync settings (see below).

When syncing is interrupted:

Double-click your iBiz project to open the pop-up inspector. Uncheck “Sync with iCal” (if nec-
essary) and check it again, then make sure the correct calendar is selected next to “Calendar” 
(if syncing was suspended because the calendar was deleted from iCal, you will need to create 
a new one and then select it here). When the initial sync options window appears, choose “Send 
Events to iCal.” iBiz will send all your job events to iCal and establish a sync connection with 
that calendar. You can then resume syncing as usual.

When all else fails:

If you have followed all of the steps above to configure synchronization for your iBiz project, 
and for some reason it still will not sync, there is one last resort that you can use to try to 
“jump start” the sync process. Choose Project > Sync with iCal > Reset Events to clear all iBiz 
sync records and re-import all events from iCal.
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NOTE
	 This command affects all projects that have iCal sync enabled. No job events will 

be deleted from iBiz, but all events linked to your iBiz projects will be re-import-
ed, which may result in duplicates being created in iBiz. Only use this command 
as a last resort.
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How do I apply a discount to a project?

Percentage discounts

To apply a percent-based discount to a project, double-click the project to open the pop-up 
inspector. Check “% Discount” and enter a percentage to discount each of the project’s job 
events by that rate.

Once a discount has been applied, the project’s job events will show discounted amounts in 
the “Amount” column. The amounts will be displayed in orange to indicate that they have been 
discounted. Percentage discounts are applied to all job events in the project, including deduc-
tions (see below).

Deductions (flat rate discounts)

To apply a deduction or flat rate discount to a project, add a job event and set its type to “Flat 
Rate.” Enter a negative number in the event’s “Rate” field: iBiz will automatically consider it 
to be a deduction and change the job event’s color to red. It will not be counted towards the 
project’s gross earnings, but will be factored into the net totals when you generate an invoice.
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NOTE
	 Deductions and percentage discounts are calculated in two separate stages when 

invoices and reports are created. The [DISCOUNT AMOUNT] template tag is used 
to display the amount of the percentage discount, and the [DEDUCTIONS TOTAL] 
tag is used to display the amount of the deductions. For more information about 
how discounts are calculated and applied, see How does iBiz calculate its figures 
during the billing process? in Chapter 8: Templates.
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How do I use To Do items?

To Do items are designed to allow you to attach reminders to a project that don’t need to be 
tracked as job events. For example, you may need a reminder to schedule that appointment by 
a certain date, or to pick the kids up after work.

Adding To Do items

To create a To Do item, select a project from the project list, then click the  button at the 
bottom of the info pane. Double-click anywhere in the To Do list to create a new, untitled To 
Do item. You can also create new To Do’s by clicking the  button at the bottom of the To 
Do list or choosing Project > Add To Do.

Editing details

To edit a To Do item, double-click on it to open the 
pop-up inspector.

Name:•	  Enter a name here to identify the item.

Due Date:•	  To assign a due date, check this box and 
type in the date by which the item should be completed. 
A gray exclamation image  will appear next to a To Do 
item when it is overdue.
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Priority:•	  Click to choose a priority for the item: None , Low , Medium , or High . 
You can also cycle a To Do item’s priority setting by clicking on the priority icon in the To 
Do list.

Notes:•	  Enter any additional details you want to remember about the To Do item here.

NOTE
	 iBiz Client users will also see an “Assigned To” column in the To Do list. Double-

click in this column and type in a name so that other iBiz Client users will know 
who is expected to complete each task (if desired). If you cannot edit this column, 
your permissions may be restricted by iBiz Server.

Changing status

The checkbox to the left of each To Do indicates whether or not the item has been completed: 
check an item to mark it complete; uncheck an item  to mark it incomplete. Completed To 
Do items appear in gray.

Syncing with iCal

To Do items are automatically synced with iCal whenever the project to which they belong is 
synchronized. To read more about syncing projects with iCal, see How do I synchronize proj-
ects with iCal? in this chapter.
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Sorting and filtering

The To Do list can be sorted according to status, name, or priority by clicking the appropriate 
column headings. Clicking a second time will reverse the sort order. To Do items can also be 
filtered by choosing “Show Completed” or “Show Incomplete” from the pop-up menu at the 
bottom of the list. Select “Show All” to make all To Do items visible again.

Deleting To Do items

To remove a To Do item from the list, select it and click the  button at the bottom of the To 
Do list, or choose Project > Delete To Do.
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How do I use the File Cabinet?

The File Cabinet allows you to link external files with your iBiz projects. For example, let’s say 
that part of your work on a project involves editing an image file in Photoshop. The File Cabinet 
allows you to open that document from within iBiz and automatically track how much time you 
spend working on it. By tapping into the power of the Document Monitor, iBiz will record only 
the time spent with that file in the foreground: switch to a different program, and iBiz stops the 
timer; switch back, and iBiz starts the timer again.

Adding files to the File Cabinet

Select a project from the project list and click the  button to reveal that project’s File Cabi-
net. Double-click anywhere in the file list or click the  button at the bottom of the list and 
select the file you want to add. You can also drag and drop files (and folders) directly from the 
Finder into the File Cabinet.

NOTE
	 When you add a file to the File Cabinet, iBiz does not make a copy of the file - it 

simply creates a link to the file, wherever it may be stored. If you move or delete 
the file, iBiz will lose track of it and display the file name in red. Return the file to 
its original location to repair the link.
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Opening files and tracking time

Double-click on a file in the File Cabinet to show the pop-up inspector.

The inspector shows the location of the file on your 
Mac. Click anywhere in this file path to open the file. 
Click the “Options” button to pop up a list of com-
mands. You can also access these commands by 
clicking the small gear-shaped button  that ap-
pears when you select a file in the File Cabinet list:

Monitor and Create Event:•	  Go to this menu item and choose one of your custom job 
events from the drop-down menu that appears (only timed events are shown). A new job 
event will be created (based on the item you selected) and a timer will be started on that 
event. Each time you switch to and from the file you opened, the timer will be started and 
stopped, respectively, on the associated job event. Close the file, and iBiz will stop logging 
time. The next time you open the file (with iBiz open and the Doc Monitor enabled), its 
associated job event will automatically resume logging time for it.

Monitor Selected Event:•	  Choose this item to have iBiz open the file and automatically 
start a timer for whatever job event is currently selected in the job event list. Each time you 
switch to and from the file you opened, iBiz will start and stop, respectively, the associated 
job event’s timer. Close the file, and iBiz will stop logging time. The next time you open 
the file (with iBiz open and the Doc Monitor enabled), its associated job event will auto-
matically resume logging time for it.
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NOTE
	 Logging time automatically through the File Cabinet requires that Universal Ac-

cess is enabled on your computer. Make sure “Enable access for assistive devices” 
is checked under the Unversal Access pane in System Preferences.

Open File:•	  Choose this option to simply open the selected file. No time will be logged, 
unless you previously used one of the options above and the Doc Monitor is enabled (in 
which case the job event associated with the file will continue logging time).

 TIP
	 To quickly open a file in your File Cabinet, Control-click a project in the project 

list, go to “File Cabinet” and choose a file from the list that appears. 

Reveal in Finder:•	  Choose this option to open a window in the Finder containing the se-
lected file. No time will be logged as a result.

Removing files from the File Cabinet

Select a file in the File Cabinet and click  at the bottom of the list, or press the ‘Delete’ key 
on your keyboard. The original file will not be deleted from your hard drive; it will simply be 
removed from the File Cabinet list in iBiz.
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How do I search for a particular project or filter 
the project list?

Searching projects

You can search for a project by using the search box in the tool-
bar. Click the magnifying lens in the search box and select any of 
the options listed under “Search Projects.” Then begin typing your 
search criteria into the box.

iBiz will automatically hide any projects associated with the se-
lected client that do not match your search criteria. To exit the 
search and show all of your projects again, click the ‘x’ button 
inside the search box.

Filtering projects

To filter out projects based on their status, use the buttons displayed next to the “Billing” tab 
above the project list. Click the appropriate button(s) to hide any combination of open, closed, 
on hold, or cancelled projects, or projects with a start date in the current year:

Clicking a second time will reveal the corresponding projects again. These same filters are also 
located under Project > Show. Note that filtering out projects will not delete them from iBiz, 
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only hide them temporarily. You can turn off project filters at any time by choosing Project > 
Show All Projects.

NOTE
	 When filtering projects, iBiz will display how many projects are currently displayed 

out of the total at the bottom of the project list. When all projects are showing, 
“No projects filtered out” will be displayed.

To set the fiscal year start/end date used when filtering “This Year,” Choose iBiz > Preferences 
and click the  Advanced button. Change the month and day to indicate the desired date.
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How do I move or reassign a project from one 
client to another?

It’s as easy as drag and drop! To reassign a project to a different client, click the project and 
drag it onto client with which you want it to be associated. Trying to copy & paste a project 
from one client to another will not work - the copy command will automatically copy whatever 
job events are selected instead of the projects you want to move.
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How do I recover a deleted project?

Sometimes even the best of us delete a project by accident. Fear not - there is still a way to 
recover projects after they have been deleted!

In the Finder, browse to the following folder: /Users/yourUserName/Library/Application 
Support/IGG Software/iBiz/Projects/Deleted Projects/

Sort the files here by “Date Modified” to help you figure out which one you need to restore - 
the date and time the file was last modified should match when the project was deleted. When 
you think you have found the right one, drag and drop the file onto the appropriate client in 
the main iBiz window. The project should load back into iBiz, ready for editing once again. If it 
turns out to be the wrong project, delete it and try another file.

NOTE
	 iBiz Pro users should drag and drop the project file onto the appropriate client 

name in iBiz Server. 
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What are job events all about?

In iBiz, job events fall under clients and projects, and are the main component for tracking the 
work you perform for each project. They are used to bill for time at an hourly rate, for flat fees 
and expenses, for quantities of items bought or sold, and for mileage logged on a vehicle. Job 
events are also used to create estimates, and can be used to record work that will not be billed 
to your clients.

Viewing the job event list

Show the job event list by selecting a client, clicking the “Project” tab, and selecting a project. 
The job event list appears below the project list, in the bottom half of the main window.
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NOTE
	 The job event list shows only those job events belonging to the project that is 

currently selected in the project list. Selecting multiple projects will display only 
those job events associated with the last project selected.

Click the “Estimate” tab to enter job events for the purpose of creating an estimate, or click the 
“Work” tab to enter job events for the purpose of recording the work you actually perform (and 
ultimately for creating an invoice to bill the client). Each project remembers which tab (“Esti-
mate” or “Work”) was last open; when the project is selected, it will automatically open the tab 
that was used last.

Double-click any job event in the list to view and edit information about it using the pop-up 
inspector.

Organizing the job event list

The job event list can be sorted by any of the column headings at the top of the list. Clicking 
a heading once will sort the job events according to the information in that column; clicking a 
second time will reverse the direction of the sort.

You can show or hide individual columns by checking and un-checking them in View > Job 
Event Columns. Columns can be resized by clicking and dragging the divider between two 
column headings. The order in which columns are displayed can be changed by clicking and 
dragging the column headings themselves. For a description of the information contained in 
each column, see How do I edit job event status/information? in this chapter.
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Additional job event features

Along with the job event list, iBiz uses the info pane to keep track of some additional job 
event-related information: The workday pane shows a calendar-style display of all timed 
events recorded on the same date as the selected job event. The timer log maintains a record 
of every start and stop of the timer for the selected job event.
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How do I add and delete job events?

Adding job events

To create a new job event, first make sure you have selected a client, clicked the “Projects” 
tab at the top of the main window, and chosen a project. If you want to start adding events to 
an estimate, click the “Estimate” tab in the lower half of the window (or choose View > Show 
Estimate Job Events). To add events for work you actually performed (and intend to bill on an 
invoice), click the “Work” tab (or choose View > Show Work Job Events).

Click the  button at the bottom of the job event list and choose “Add Job Event.” iBiz will 
create a new timed event with the name “Untitled” and the current date. The pop-up inspector 
will open automatically so that you may edit the job event’s details. You can also create new 
job events by choosing Job Event > Add Job Event, or by double-clicking an empty space in the 
job event list.

Clicking the  button will also show commands to create job event groups and custom job 
events. Read more about these features later on in this chapter.

 TIP
	 By default, new job events are created with their rates set to ‘0.0’. If you want to 

change the default job event rate, click the  Rates & Taxes button on the 
toolbar, click “Use global rate,” and enter the rate you want to use instead.
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Deleting job events

To remove a job event from the list, select it and click the  button at the bottom of the job 
event list. A sheet will appear asking you to confirm that you want to permanently delete the 
job event. You can also delete events by pressing the ‘Delete’ key on your keyboard or choos-
ing Job Event > Delete Job Event.
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How do I edit job event status/information?

Configuring job events

Each job event has a number of options that can be 
configured using the pop-up inspector. Double-click 
any item in the job event list to show the inspector 
and configure the following options:

Name:

Type in a descriptive name here to help you quickly 
identify the job event. iBiz will suggest names from 
your custom job event list as you type; press ‘Tab’ 
on your keyboard to accept a suggestion and copy 
the rest of your custom event details to the new job 
event, or keep typing to ignore the suggestions. You 
may also click the arrow button at the right side of 
the box, or press the Down Arrow key while typing, 
to choose one of your custom job events from a list.

Type:

Choose what kind of work this job event will be used 
to record: timed, flat rate, quantity, or mileage. You 
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can also indicate non-billable and/or expense status here. To read more about these options, 
see Job event types in this chapter.

NOTE
	 Next to the “Type” field you may see a small gray arrow . Read about the I (In-

voiced) column below for an explanation. 

Rate:

Enter the hourly rate, flat fee, cost per item, or charge per mile/kilometer here (depending on 
the job event type selected). Entering a negative rate will cause the job event to be designated 
a deduction.

Time/Quanity/Mileage:

If a timed event is selected, enter the time logged for the event here. When you run a timer for 
the job event, its time will automatically be incremented.

 TIP
	 To display job event times in decimal format instead of standard time format, 

choose iBiz > Preferences, click the  Advanced button, and check “Display 
event times in decimal format.”

Click the “Recalculate Billable Hours” button to have iBiz replace the time you entered with the 
difference between the “To” and “From” fields. iBiz will not take timer logs into account when 
recalculating the time: it will only look at the dates and times entered in the “From” and “To” 
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fields. Any pauses that may have been recorded with the timer between those dates and times 
will be disregarded.

NOTE
	 The “Recalculate Billable Hours” feature can also be accessed in the workday pane 

(see below). 

If a quantity event is selected, enter the quantity of items to be billed here. If a mileage event is 
selected, enter the number of miles/kilometers to be billed here. This option is disabled for flat 
rate events.

From:

Enter the starting date and time for the job event here. If you use a timer, the starting date and 
time will be recorded automatically the first time the timer is started.

To:

Enter the ending date and time for the job event here. If you use a timer, the date and time of 
the last time you stop the timer will be recorded automatically. If you start and stop a timer 
repeatedly, those pauses will not be reflected here - the “To” field only indicates the last time a 
timer was stopped or work was ceased. Pauses are recorded in the timer logs.
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Taxable:

Check this option and enter one or two tax rates to apply taxes to the job event. These may 
be set automatically based on global tax settings or custom job event settings. Each job event 
may be assigned unique tax rates: see How do I apply taxes to job events? in this chapter for 
more information. Taxes are not calculated immediately, but will be applied when you generate 
an estimate or invoice.

Markup:

Check this option and enter a percentage to apply a markup rate to the job event. iBiz will 
immediately add the specified percentage to the event’s earnings and display this total in the 
“Amount” column (as well as include the markup amount in the relevant project columns). iBiz 
will update these figures dynamically when the job event’s rate and time/quantity/mileage are 
modified. Markup rates are calculated individually for each job event; events with the same rate 
are not summed before the markup rate is applied.

Notes:

Use this space to record additional comments or information about the job event.

Job event columns

The job event list shows a number of columns, some of which reflect the same information en-
tered in the pop-up inspector. Some options can be changed directly in the job event list, and 
some convey additional information about the status of your job events, as described below. 
Go to View > Job Event Columns to choose which columns are displayed.
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 TIP
	 You can edit the information in many job event columns without using the pop-

up inspector by holding the Option key and double-clicking the field you want to 
change.

NB (Non-Billable):•	  Check the box in this column to indicate that a job event should be 
considered non-billable.

I (Invoiced):•	  Check the box in this column to indicate that a job event has already been 
included on an estimate or invoice. When you generate an estimate or invoice, iBiz will 
ignore any job events that have already been checked off, and will automatically check this 
box for all events included on the new estimate or invoice. Job events that have this box 
checked will show a small gray arrow  in the pop-up inspector; click this arrow to have 
iBiz display the estimate or invoice on which the event appears.

Date:•	  The starting date of the job event (equivalent to the date in the “From” field in the 
pop-up inspector).

Job Event/Estimate:•	  The name of the job event (equivalent to the “Name” field in the pop-
up inspector).

Time/Quantity/Mileage:•	  The time logged, quantity of items to be billed, or miles/kilome-
ters to be billed (equivalent to the “Time/Quantity/Mileage” field in the pop-up inspector). 
Job event groups containing events of mixed types show the combined quantity and mile-
age in parentheses ahead of the total time.
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Rate:•	  The cost per hour, flat fee, expense per item, or mileage rate, depending on the job 
event type (equivalent to the “Rate” field in the pop-up inspector). Job event groups show 
the average rate of all their sub-events.

Amount:•	  The earnings generated from each job event, calculated automatically using the 
job event’s time/quantity/mileage, rate, and markup (see above) as appropriate. If a job 
event’s earnings appears in orange, it means that the earnings reflect a discount applied 
to the project.

Notes:•	  Additional comments or information about the job event (equivalent to the “Notes” 
field in the pop-up inspector).

Status colors

Items in the job event list are sometimes in different colors to show their status:

Black text•	  indicates that the job event is active and has not yet been billed (i.e. included 
on an estimate or invoice).

Gray text•	  indicates that a job event has already been billed (i.e. appears on an estimate or 
invoice), or is designated as non-billable. Refer to the ‘I’ and ‘NB’ columns, respectively, to 
see which status applies to the job event in question.

Red text•	  indicates that a job event has a negative amount. iBiz automatically considers 
these to be deductions and will treat them accordingly.

Orange text•	  in the “Amount” column indicates that the project has a discount applied to it.
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The workday pane

Select a job event and click the  button at the bottom of the 
info pane to display the “workday pane.” Here iBiz displays a 
visual representation of all job events with the same date as the 
selected job event (shown at the top of the info pane), showing 
each one as a block on a timeline. Clicking a job event block will 
display that event’s starting date/time and ending date/time at 
the bottom of the info pane. Clicking and dragging the block will 
change the job event’s start and end times; clicking and drag-
ging the bottom of the block will change the job event’s end 
time.

Use the workday pane to adjust your job event times visually, 
then click “Recalc. Billable Hours” to apply those changes to the 
job event. Be aware that recalculating in this way does not ac-
count for previous starts and stops of the timer as recorded in 
the timer log - so any idle time between the hours listed will be 
included in the new total time.

 TIP
	 To change the start and end times displayed in the workday pane itself, choose 

iBiz > Preferences, click the  Workday button, and choose the times you want 
displayed using the “Start” and “End” pop-up menu buttons.



What are the different types of job events?

Primary types

Each job event you create must be assigned one of the four primary types. To change a job 
event’s type, double-click it in the job event list to open the pop-up inspector. Click the pop-
up menu button next to “Type” to select one of the primary types. You can also change a job 
event’s type by Control-clicking it in the job event list and choosing from the “Change Type” 
submenu.

Here is a description of the four job event types:

Timed:•	  This type is used to bill according to an hourly rate. Time can be entered manually 
or logged automatically with timers.

Flat rate:•	  This type is used to bill according to a flat fee, whether it be for services per-
formed or goods purchased for the project.

Quantity:•	  This type is used to track sales of goods and bill on a per-item basis.

Mileage:•	  This type is used to track distance traveled in a vehicle and bill on a per-mile/
kilometer basis.

Additional types

In addition to the primary types, each job event may also be flagged with one or more of the 
following types:
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Non-billable:•	  This type indicates that the job event should not be included on estimates 
and invoices. This can come in handy when you want to track expenses without passing 
them on to the client, or for logging extra time that is not meant to be billed. To mark a 
job event as non-billable, double-click the job event to open the pop-up inspector and 
check “Non-billable.” Once a job event has been designated as non-billable, it will appear 
in gray text in the job event list.

 TIP
	 You can flag job events as “non-billable” directly in the job event list by enabling 

the ‘NB’ column under View > Job Event Columns, and marking the checkboxes in 
that column as appropriate.

Expense:•	  This type indicates that the job event represents a cost that you paid on behalf 
of the client, which you are passing on to the client as part of their bill. Designating job 
events as expenses allows you group them together on estimates and invoices (with proper 
template design), and track statistics on these items in your reports. To mark a job event 
as an expense, double-click the job event to open the pop-up inspector and check “Ex-
pense.”

Deduction:•	  This type is applied automatically when a job event is created with a negative 
rate. For more information about deductions, see How do I apply a discount to a project? in 
Chapter 3: Projects. Deductions appear with red text in the job event list.
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How do I apply taxes to job events?

Applying taxes to individual job events

To apply taxes to a job event, double-click it in the job event list to open the pop-up inspec-
tor. Check “Taxable” and type in the desired rates as percentages. Up to two separate tax rates 
can be applied to the same job event - if you only need to apply one rate, leave the second one 
at “0.” Each job event may be assigned unique tax rates, but if a project contains job events 
with different rates, be sure to configure your tax calculation options appropriately (see below).

Tax rates can also be assigned to custom job events, so that the rates are automatically as-
signed when you create new events based on those custom events.

 TIP
	 You can label the two tax rates in the Rates & Taxes window (underneath the 

global tax rate - see below) to help distinguish between them. Once specified, 
these labels will appear beneath the tax rates in the pop-up inspector.

Taxes are not added to the earnings displayed in the job event list; they are calculated when an 
estimate or invoice is generated.
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Setting global tax rates

Global tax rates can be established in 
order to apply the same tax rate(s) to 
all new job events. To set global tax 

rates, click the  Rates & Taxes 
button on the toolbar. Click the “Tax-
es” tab in the sheet that appears, then 
check “Use global tax rates” and enter 
the desired rate(s) as percentages.

NOTE
	 Applying global tax rates will not affect tax rates on existing job events. Any new 

job event created will be marked taxable by default and applied the global rates. 
These can still be changed on an individual basis without affecting the global 
rates. Tax rates assigned to custom job events will take precedence over global 
rates.
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Configuring tax calculation options

To control how iBiz calculates your tax rates, choose iBiz > Preferences and click the  

 Advanced button. Choose from the following options:

Calculate each event’s tax, then sum:•	  Choose this option if you have job events within 
the same project that use different tax rates. Taxes will be calculated individually for each 
job event, then added together to determine the total tax amount.

Sum events, then calculate tax:•	  Choose this option if all job events within the same proj-
ect use the same tax rates. Use this option even if you mix taxable and non-taxable events 
- the important thing is that your taxable events all use the same rates. Your earnings will 
be summed before the taxes are calculated.

Compound taxes:•	  This option is only available if you select the second calculation 
method above. Check this option to have iBiz calculate the two tax rates in consecu-
tive stages - that is, iBiz will calculate the Tax 1 amount and add it to your earnings 
before calculating the Tax 2 amount and determining your total tax amount. Leaving 
this option unchecked will cause iBiz to calculate each tax as a percentage of the 
original earnings.

NOTE
	 Due to rounding procedures, in many cases the two calculation methods produce 

different results when applied to the same job events. Be sure to choose the 
method that is most appropriate for your needs.
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What are custom job events?

Custom job events allow you to store details of job events that you use frequently, so that you 
can quickly create job events with the same settings. For example, window cleaning may be a 
service that you perform frequently, and it always bills at the same rate with the same taxes 
applied. By creating a custom job event called “Window cleaning,” you can easily add this event 
to any project without having to re-type the name, rate, and tax information every time, just by 
choosing the custom event from a list.

Creating custom job events

Click the  Rates & Taxes button on the toolbar and click the “Job Events” tab, or click the 
 button at the bottom of the job event list and choose “Edit.”

In the custom job event window, click the  button to add a blank custom job event to the 
list. Enter a name, type, rate, and any other information you want to associate with the job 
event using the fields provided. For a description of these options, see How do I edit job event 
status/information? in this chapter.

 TIP
	 You can easily create a custom job event based on an existing job event by select-

ing an item in the job event list and choosing Job Events > Create Custom Job 
Event from Selection.
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Custom job events can be edited at any time by revisiting the Rates & Taxes window. Changes 
made to your custom events will only affect new job events you create with them - job events 
that have been added to your projects already will not be affected.

Adding custom job events to your projects

Once you have created some custom events in the Rates & Taxes window, add them to your 
projects by clicking the  button at the bottom of the job event list and choosing the event 
you want to add. The order in which your events are displayed reflects their order in the Rates 
& Taxes window - change the order in which are they displayed by opening that window and 
clicking and dragging each event to the desired location.

 TIP
	 Creating a custom job event from a job event group will store all its sub-events as 

well. This allows you to add an entire set of job events to a project with one click, 
which can come in handy when your projects require the same set of tasks to be 
performed each time.

Custom job event settings can also be applied to existing job events. Double-click a job event 
to open the pop-up inspector, then click the arrow in the “Name” box and choose a custom 
event from the drop-down menu that appears. You can also begin typing the name of one of 
your custom job events in the “Name” box. iBiz will suggest names from your custom event 
list as you type; press ‘Tab’ on your keyboard to accept a suggestion and copy the rest of your 
custom event details to the new job event.
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NOTE
	 Job events that are created automatically as the result of syncing a project with 

iCal will automatically have custom event details applied to them. Just be sure the 
iCal events have names that match your custom event names, and iBiz will assign 
them the appropriate settings when they are synced.

Deleting custom job events

To delete a custom job event, click the  Rates & Taxes button on the toolbar, select the 

event you want to delete, and click the  button. Only the custom event will be deleted - 
copies of the custom event that have been added to your projects will not be affected.

Notes for iBiz Pro users

iBiz Server has the capability to administer a list of custom job events centrally for all iBiz Cli-
ent users to share. If this feature is enabled, you will not be able to edit the custom event list 
from iBiz Client. Additionally, iBiz Client users may be restricted from accessing the custom job 
event list - see How do I manage network user permissions? in Chapter 9: Networking for more 
information.
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How do I group job events?

Job event groups can be created to help you better organize your job events. Think of groups 
as folders in which job events (sub-events in this case) can be kept.

You may, for example, want to organize all of your job events for a project according to the 
day on which the work was performed - so you create a job event group for each day. Or you 
may wish to group your job events according to the type of work performed, regardless of 
what day they were completed - so you create a job event group for each job event category.

Adding job event groups

To add a group to your job event list, click the  button at the bottom of the list and choose 
“Add Job Event Group” from the pop-up menu, or choose Job Event > Add Job Event Group. A 
new job event group will be created, and the pop-up inspector will open automatically to allow 
you to enter a name for the group. Click “Done” to save the name and close the inspector.

Job event group status

The status and information displayed for groups differs slightly from that of regular job events:

‘NB’ (Non-Billable):•	  Indicates whether or not the group’s sub-events are designated as 
non-billable. A checkmark indicates that all enclosed sub-events are non-billable; a 
dash  indicates that some of them are, and an empty box  indicates that none of them 
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are. Check the box next to the group to check off all its sub-events; uncheck it to uncheck 
all its sub-events.

‘I’ (Invoiced):•	  Indicates whether or not the group’s sub-events have been billed (i.e. in-
cluded on an estimate or invoice). A checkmark indicates that all enclosed sub-events 
have been billed; a dash  indicates that some of them have, and an empty box  indi-
cates that none of them have. Check the box next to the group to check off all its sub-
events; uncheck it to uncheck all its sub-events.

Date:•	  Indicates the starting date for the group of events. This can be edited using the pop-
up inspector.

Job Event/Estimate:•	  Indicates the name of the group and should be used to quickly re-
mind you which sub-events are enclosed. This can be edited using the pop-up inspector.

Time:•	  Displays the total time logged for enclosed sub-events. If the group contains quan-
tity and/or mileage sub-events in addition to timed sub-events, the combined quantity 
and mileage will be displayed in parentheses before the total time.

Rate:•	  Displays the (mean) average of the enclosed sub-events’ rates.

Amount:•	  Displays the total earnings from enclosed sub-events.

Notes:•	  Used to track additional comments or information about the job event group.

Adding sub-events to a group

Select the job event group.1.	

Click the 2.	  button at the bottom of the job event list.
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Choose “Add Job Event” from the pop-up menu to add an “Untitled” sub-event, or choose 3.	
one of your custom job events. iBiz will automatically create the job event inside of the 
group.

To view the sub-event, click the small triangle to the left of the group to display all its 4.	
enclosed sub-events: 
 

Edi5.	 t the sub-event and use it the same as you would any other job event.

 TIP
	 You can also add existing job events to a group by dragging and dropping them 

onto the group in the job event list. Remove job events from a group by dragging 
them to another place in the job event list.

Job event groups cannot be created inside existing groups.

Invoicing job event groups

Job event groups can also be used to control how your job events are displayed on estimates 
and invoices. If a group is expanded (all enclosed sub-events are visible) in the job event list 
when you generate an estimate or invoice, each sub-event will be detailed underneath the job 
event group on the estimate or invoice. If the group is condensed (only the group itself is vis-
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ible) in the job event list, the estimate or invoice will display summary information for the job 
event group only.

Deleting job event groups

To delete a group from your job event list, select it and click the  button at the bottom 
of the list. A sheet will appear asking you to confirm that you want to permanently delete the 
group. All enclosed sub-events will be deleted together with the job event group.
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How do I use timers?

Timers let you track the time you spend working on individual job events. You can use timed 
events to log billable hours, or simply track the time you put into a flat rate event (use a non-
billable timed event for this purpose).

NOTE
	 You can have as many job events running timers simultaneously as you like. If you 

would prefer to only run one timer at a time, choose iBiz > Preferences and check 
“Starting a timer stops all other timers.”

Tracking time for existing job events

To log time for a job event that has already been added to one of your projects:

Select the job event you would like to start a timer for. Its type must be set to “Timed.”1.	

Click the 2.	  button at the bottom of the job event list, or choose Job Event > Toggle 
Timer.

To stop timing, click the 3.	  button or choose Job Event > Toggle Timer again.

There are a number of ways iBiz reminds you that you have a timer running. When time is be-
ing logged, a small clock icon  appears next to the recorded time in the job event’s “Time” 
column and next to the client under which the job event is filed. The associated project will 
appear in bold in the project list, and a red badge  will appear on the iBiz Dock icon dis-
playing the number of currently running timers.
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NOTE
	 iBiz timers do not record time while your Mac is asleep or you are logged into 

another user account via Fast User Switching. Waking up your Mac or switching 
back to the user account that is running iBiz causes the timers to resume, but the 
time logged in between is counted.

iBiz includes the ability to round the time you log for your job events. See How do I round time 
logged for my job events? in this chapter for more information.

Discounting idle time

Have you ever forgotten you had a timer running and taken a break from the computer, only 
to return and find you logged two hours more than you actually worked? iBiz can check to see 
if the mouse has been moved in a specified period of time, notify you that you have been idle, 
and let you choose whether to subtract the extra time.

To enable “idle time,” go to iBiz > Preferences and drag the slider to specify a time under “Idle 
Time & Timer:”

Whenever iBiz detects that your mouse hasn’t moved for the amount of time you specified 
(regardless of whether your Mac has been asleep), it will pop up a window showing all the 



115Chapter 4: Job Events

active timers and asking you which ones to discount the idle time (displayed near the top of 
the window) from. Check any timers from which you want to remove the time, and click “OK.” 
The idle time will be subtracted from the timers you indicated, and all the timers will continue 
recording time.

Viewing timer logs

Each time you start and stop a timer, iBiz records this in a log attached to the job event for 
which you are recording the time. Select the timed job event you wish to view the log for, and 
click the  button at the bottom of the info pane. iBiz will display the log for that particular 
timer, which includes an entry for each time the timer was started and stopped by clicking the 

 button (or using the “Toggle Timer” command).
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Any time that is entered manually, recalculated via the 
workday pane, or added from the Doc Monitor is not 
included in the timer log. To save a timer log to a plain 
text file for use with another program, click the “Export” 
button at the bottom of the info pane, enter a name for 
the file, and click “Save.” 

 TIP
	 iBiz Pro users will also see the name of the user who started or stopped the timer 

next to each log entry. This information can be used by the report features to 
analyze the time logged by your employees.

Using quick timers

Quick timer events let you very quickly start a timer without having to create a job event in one 
of your projects beforehand. All quick timer events are “unfiled” - that is, they are not associ-
ated with any client or project. Quick timer events can be accessed via a floating window or the 
main menu bar (see below).

To access the quick timer window, click the  Quick Events button on the toolbar, or 
choose Job Event > Show Quick Timer Events. The floating window that appears will stay visible 
regardless of what application you are using:
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To create a new quick timer event:

Click the  button to add an “Untitled” event, or click the  button and choose one of 
your custom job events from the menu that appears.

To start a timer for the selected event:

Click the  “play” button at the top left of the floating window; clicking the  “pause” 
button will stop the timer. Events that are currently timing will appear with bold text in the 
quick timer window.

You can time as many quick events simultaneously as you wish. Select a quick timer event 
in the list to show its current time in the large display at the top of the floating window. An 
event’s name and time can be edited by double-clicking them.
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 TIP
	 Show and hide columns in the floating window to display only the information you 

need. Click the  button to the right of the column headings and choose an item 
to toggle that column’s visibility.

To assign a quick event to a project:

Once you are done timing a quick event, select it and click the “Show More” button, then 
choose a client, project, and job event group (if desired) from the corresponding pop-up menu 
buttons:



119Chapter 4: Job Events

Enter a rate and additional notes if desired, then click the “Commit” button to add the quick 
event to the designated project. iBiz will remove it from the quick events list automatically. 
Click the “Show Less” button to return the floating window to its previous state.

NOTE
	 To quickly assign a quick timer event to a project, simply drag & drop it from the 

floating window onto the desired project. 

To delete a quick timer event:

Select the event you want to delete from the quick timer window, and click the  button. 
The time will be discarded and the event permanently removed from iBiz.

Using the quick timer menu

To access your quick timers from the main menu bar, choose iBiz > Preferences and check 
“Show Quick Timer in top menu bar.” A small stopwatch icon will appear at the top of your 
screen towards the right side of the menu bar. The icon appears differently depending on its 
status:

•	  If no events are currently logging time, the menu bar timer will appear in a light shade 
of gray.

•	  If any events are currently logging time (regardless of whether they are quick timers or 
regular job event timers), the menu bar timer will appear in black.
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•	  If a quick timer is currently running, the menu icon will display the time 
logged as well.

Click the menu bar timer to drop down a list of options for your timers:

Make New and Start Timer On:•	  Choose either “Untitled” or one of your custom job events 
to create a new quick timer and start logging time for that event. The event will be added 
to the floating window and can be toggled under the quick timer menu.

Toggle Timer On:•	  All events listed in the quick timer window appear in this section. Select 
one from the list to start or stop its timer. A small clock icon displayed next to an item 
indicates that its timer is currently running.

Other Running Timers:•	  Any job events that are not in the quick timer window, but filed 
under your projects, will display in this section if they are currently running timers. Select 
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one from the list to stop its timer. To restart the timer on one of these job events, you will 
need to locate it in the main iBiz window.

Show Quick Timer Events:•	  Choose this item to open the quick timer window and view, 
edit, or assign your quick events.
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How do I round time logged for my job events?

iBiz provides the option of rounding any time that you have recorded for your timed job events. 
You can choose to round the time on any existing job event at the click of a button, or have 
iBiz automatically round your time whenever you stop a timer.

Rounding time manually

To round time that has already been logged for one of your job events, select a timed event 
and click the  button at the bottom of the job event list. Go to “Round Time” and choose 
one of the available increments. iBiz will immediately round the current time up to the nearest 
increment.

Rounding time automatically

To have iBiz automatically round the time on timed events whenever their timers are stopped, 
choose iBiz > Preferences and check “Automatically round time when timer is stopped.” 
Choose a rounding increment from the pop-up menu button, and it will be applied automati-
cally each time you stop a timer on a job event or quick timer event.
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How do I use the Document Monitor?

The Document Monitor is designed to 
help you track the time you spend 
using different files and programs on 
your computer, then quickly transfer 
the time logged to your existing job 
events. A project manager, for in-
stance, may use the Document Monitor 
to measure how much time she spends 
using Photoshop, Mail, and iBank, then 
assign the time logged to job events 
named “Marketing,” “Communications,” 
and “Budgeting,” respectively. This 
feature is intended to complement to 
the other timers, and is used by the 
File Cabinet. In iBiz 4, the Doc Monitor 

can be controlled from the main menu bar in addition to the Doc Monitor window (see below).

Monitoring your activity

Choose File > Show Document Monitor, or click the  Doc. Monitor button on the toolbar, 
to open the Document Monitor window.
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Click the “Start Monitoring” button to begin tracking your activity. You should see an entry for 
“iBiz” appear immediately. Other items will appear when you switch to other applications. You 
can keep the Doc Monitor window open while it is monitoring your activity, or you can close it 
and allow iBiz to continue monitoring in the background.

NOTE
	 The Doc Monitor requires Universal Access to be enabled on your computer. Make 

sure “Enable access for assistive devices” is checked under the Universal Access 
pane in System Preferences.

Each time you switch to another application, it is added to the list in the top half of the Docu-
ment Monitor window. Time is logged only for the window which is currently active; other 
windows open in the background will not log time until they are brought to the foreground. In 
this way, the Doc Monitor only logs time for one window at a time, and will always be logging 
something (whatever is currently in the foreground).

The total time logged for each application is listed next to its name in the top half of the Doc 
Monitor window. Clicking the small triangle next to an application will reveal a list of all the 
windows that were viewed, and the time spent with each one.

For each item, the Doc Monitor keeps a log containing the start time, end time, and duration of 
viewing. Every time you switch from one window to another, one log entry is closed and an-
other is created. These logs are displayed in the bottom half of the Document Monitor window.

Selecting an application or window from the list in the top half of the Doc Monitor will allow 
you to view the log for that item in the bottom half of the window. You can clear logs for the 
selected item, or all logs, by clicking the “Manage” button and choosing the corresponding 
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item from the drop-down menu. Pressing ‘Delete’ on your keyboard will also delete the se-
lected item(s) from the Doc Monitor.

 TIP
	 If you use the Doc Monitor frequently, you can have iBiz automatically start moni-

toring whenever the program is launched. Choose iBiz > Preferences and check 
“Start Doc Monitor on launch” to enable this feature. The Setup Assistant asks you 
to choose a setting for this feature the first time you launch iBiz.

Stopping activity monitoring

When you are done and no longer want iBiz to monitor your activity, choose File > Show Docu-

ment Monitor (or click the  Doc. Monitor button on the toolbar) to open the Document 
Monitor window, then click “Stop Monitoring.” iBiz will not add any more time to the Doc Moni-
tor, but the time that was already logged will remain so that you can assign it to your projects.

Assigning logged time to your projects

Once you have recorded time, you can decide how you want the time to be assigned to your 
iBiz projects. You can parcel out the time as you see fit, assigning each record to a different 
job event, adding several records to the same job event, and even leaving some records unas-
signed as your work requires.

To assign time to your projects, drag and drop any item from the Document Monitor onto an 
existing job event (it must be a timed event) in one of your projects. You can drag an applica-
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tion or window from the top half of the Document Monitor, or you can drag specific log items 
from the bottom half. Command-click to select multiple items. Whatever time you drop onto a 
job event will automatically be added to the job event’s timer.

Using the Doc Monitor menu

iBiz 4 adds the ability to control the Document Monitor from the main menu bar in addition to 
the Doc Monitor window. To enable this feature, go to iBiz > Preferences and check “Show Doc 
Monitor in top menu bar.” The Doc Monitor icon will appear at the top of your screen towards 
the right side of the menu bar. The icon appears differently depending on its status:

•	  The Doc Monitor menu is enabled but monitoring is currently stopped.

•	  The Doc Monitor is currently monitoring your activity. The icon of the ap-
plication that is currently in the foreground is displayed along with the total time logged 
for that application.

Click the Doc Monitor menu to drop down a list of options:

Start/Stop Monitoring:•	  Choose this option to start or 
stop activity monitoring with the Document Monitor.

Applications:•	  A list of all applications for which time 
has been logged appears in the middle section of the menu, 
along with the total time logged for each program. Select 
an application to show a list of all windows within that app 
for which time has been logged, and their respective times. 
Choose “Show” under any application to bring that program 
to the foreground.
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Manage:•	  Choose this option to open the Doc Monitor window in iBiz to start/stop moni-
toring or assign the logged time to your projects.



128 Chapter 4: Job Events

How do I move job events between projects?

To move a job event from one project to another, use cut and paste. Select the job events you 
want to move and choose Edit > Cut to remove them from the current project. Then select the 
project to which you want to add the job events and choose Edit > Paste. You cannot drag and 
drop job events to move them between projects.
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What are invoices and estimates all about?

Once you have finished recording the work you performed, typically you will want to bill your 
clients so that you can receive payment for that work. iBiz includes handy features for drafting 
and delivering professionally-designed invoices and estimates with very little effort.

Invoices detail the job events, earnings, expenses, taxes, discounts, and any other 
information you wish to include about the projects when requesting payment. 

Estimates allow you to detail job events recorded for work that has not yet been 
performed, so that you can send a quote to the customer about the anticipated cost 
of a project. Estimates are generated and sent to clients in the same manner as 
invoices, with only minor differences.

iBiz uses a template-based system to allow a high level of flexibility and control over your 
estimates and invoices. Use the built-in templates to get started quickly, or build your own 
templates from scratch to customize the information your clients receive.
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How do I create an invoice or estimate?

Setting up an estimate

The first step in creating an estimate is entering job events under the “Estimate” tab of a proj-
ect, in order to estimate the value of the work you intend to perform. Select a client and proj-
ect, click the “Estimate” tab, and add job events to record the anticipated earnings. Skip ahead 
to the section titled “Generating the estimate/invoice” to continue.

Setting up an invoice

Invoices are set up exactly the same as estimates, with the only difference being that the job 
events are recorded under the “Work” tab instead of the “Estimate” tab. Select a client and proj-
ect, click the “Work” tab, and add job events to record the work you actually performed.

If you previously set up an estimate for this project and want to copy the job events from the 
“Estimate” tab to the “Work” tab, click the “Estimate” tab, then click the  button and choose 
“Copy Events to Work Tab.” Click on the “Work” tab and modify the events as needed to match 
the work you actually performed.

Generating the estimate/invoice

Once you have finished recording the job events for a project, you are ready to draft an es-
timate or invoice. Select the project you want to bill, and make sure the appropriate tab is 
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selected (“Estimate” for estimates, “Work” for invoices). Click the  button at the bottom of 
the project list (or choose Billing > Create Invoice with Template), and choose a template from 
the list that appears.

All job events listed in the current project that have not been billed already (i.e. have not been 
marked “Invoiced”), and are not marked “Non-Billable,” will be included on the new estimate or 
invoice. A number is assigned to the estimate/invoice automatically. iBiz will open a preview 
window to let you customize a few options before delivering and saving it.

To bill multiple projects at once:

If you want to include multiple projects on the same 
estimate or invoice, select a client, make sure the proj-
ects you want to bill are not hidden from view, and 
choose Billing > Advanced Invoice Options. Choose the 
“Selected Projects” option, Command-click to select 
multiple projects in the list, and choose a template from 
the pop-up menu button (be sure to choose a template 
that has been designed for use with multiple projects). 
Click “Generate Invoice” to proceed: all job events in the 
selected projects that are billable and have not already 
been billed will be used to create the new estimate/
invoice.
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 TIP
	 To quickly bill multiple projects, select a client and Command-click in the project 

list to select the projects you want to bill. Click the  button at the bottom of 
the project list, and choose a template that has been designed for use with mul-
tiple projects.

To bill events from a specific date range:

If you want to generate an estimate or invoice for job 
events within a specific date range only, select a client, 
make sure the projects you want to bill are not hidden 
from view, and choose Billing > Advanced Invoice Op-
tions. Choose the option, “Job Events in Selected Projects 
with Dates Between,” then enter the start and end date 
(and time) for the range you want to include. Command-
click to select multiple projects in the list, and choose a 
template from the pop-up menu button (choose a tem-
plate that has been designed for use with multiple proj-
ects if necessary). Click “Generate Invoice” to proceed: all 
job events in the selected projects that fall within the 
specified date range, are billable, and have not already 
been billed will be used to create the new estimate/
invoice.
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Previewing the estimate/invoice

After telling iBiz to generate your estimate or invoice using one of the methods described 
above, a preview window will appear. The yellow and black stripes across the top of the win-
dow are there to remind you that the estimate/invoice has not yet been saved to the client’s 
billing account. Review the estimate/invoice contents to make sure all the information is cor-
rect. If you need to make any changes to the contents of the estimate/invoice, you can make 
them directly in the preview window (RTF templates only - HTML templates require you to 
cancel the preview and start over).
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Along the right side of the window you will find some additional options and information per-
taining to the estimate or invoice:

Client:•	  The name of the client for whom the estimate or invoice has been generated.

Due date:•	  The date by which payment is expected for this invoice (disregard for esti-
mates). If you want to post a reminder for this due date in iCal, check “Add due date to 
iCal.” The following two options will be enabled as a result:

Calendar:•	  Choose which of your iCal calendars you want the reminder to appear on.

Alarm:•	  If desired, attach an alarm to the iCal event so that iCal will send you an 
email, display an alert message, or play a sound to remind you that payment is due. 
Use the options that appear below to configure the selected alarm.

Unpaid balance:•	  The current balance of the client’s billing account (excluding this invoice).

Project(s) total:•	  The total amount of new charges added by this invoice, or the total value 
of this estimate.

New balance:•	  The new balance of the client’s billing account, including charges added by 
this invoice.

 TIP
	 By default, invoice due dates are set to 30 days after the invoice creation date. 

To change this default setting, go to iBiz > Preferences, click the  Advanced 
button, and change the “Invoices due after” setting.
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Delivering the estimate/invoice

The preview window contains two options for delivering the invoice/estimate to the client. 
Click the “Delivery Options” button at the bottom-left corner of the preview window to choose 
one or both of them:

PDF Attachment Using Mail:•	  Choose this option to generate a new message in Apple Mail 
addressed to the client. iBiz will create a PDF copy of your estimate or invoice and attach it 
to the email. Mail will open automatically and display your message - enter any additional 
notes and click “Send” to deliver the estimate/invoice to the client.

Print:•	  Choose this option to print a copy of the estimate/invoice. You can also use the PDF 
button in the Mac OS X print window to save a PDF copy of the estimate/invoice on your 
computer.

Saving the estimate/invoice

Click the “Done” button at the bottom-right corner of the preview window to save the estimate 
or invoice to the client’s billing account and update the account balance accordingly. To dis-
card the invoice/estimate without saving, click “Cancel” - the client’s billing account will not be 
affected.
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How does iBiz number invoices and estimates?

Every time you create a new estimate or invoice, iBiz automatically assigns a number to it. 
When you generate an invoice, iBiz looks at the last invoice you saved, increments that number 
by one, and assigns that number to the new invoice. When you generate an estimate, iBiz does 
the same thing, but next time you generate an invoice it will not increment the number for that 
invoice - the invoice will be assigned the same number as the estimate you just saved.

Adjusting estimate/invoice numbers

iBiz tracks the number to be assigned to the next estimate or invoice internally. To modify this 

number, choose iBiz > Preferences and click the  Advanced button. Enter the number you 
want assigned to your next estimate or invoice where it says “Next Invoice Number.” The next 
estimate/invoice you generate will be assigned that number, and each subsequent one will 
increment the number accordingly.

After an estimate or invoice has been sent and saved to the client’s billing account, you can 
edit the number assigned to it using the pop-up inspector. Please note that the contents of 
the estimate or invoice will not be updated to reflect the change; they will retain the number 
that was originally assigned (unless you did not display the estimate/invoice number in its 
contents).



Estimate/invoice numbers vs. project numbers

It is important to note that iBiz draws a distinction between the numbers assigned to your 
estimates and invoices and those assigned to your projects. The items are numbered sepa-
rately; that is to say, project numbers and estimate/invoice numbers are not coordinated, so 
generating an invoice from a project will not result in the invoice being assigned the same 
number as the project from which it was created. It is possible to keep your project numbers 
and estimate/invoice numbers in sync, but will likely require you to change the latter number 
(as instructed above) each time you want to generate a new estimate or invoice.
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How do I customize my invoices and estimates?

Estimates and invoices are generated using your installed templates. iBiz comes with several 
professionally-designed templates already installed, so that you can start using the billing 
features right away. It also includes a full-featured template editor to allow you to customize 
your estimate and invoice templates to meet your specific needs. For more information, see 
Chapter 8: Templates.
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What are billing accounts all about?

Billing accounts are a convenient way to manage your clients’ financial activity. Here you can 
keep a record of the estimates and invoices that have been sent to your clients, send remind-
ers, record payments collected, and create account statements.

About client-centered billing

iBiz uses client-centered billing. This means that all cash flow for the work you do or payments 
you receive from a customer go through a client. For example, let’s say you have a customer 
that gives you a $500 deposit to work on a project making a new brochure for their travel 
company. This $500 would be entered under the appropriate client (as opposed to entering 
it as an item at the project level) as a payment. Then, say you have finished the brochure and 
you want to bill your client for all of the work you have done, you would make an invoice for 
the project and that $500 credit would be applied to the invoice. If you were to look under the 
“Billing” tab in iBiz for that client, you would see both the recorded payment and the invoice 
you sent to the client.

As a result of this approach to billing, it is not possible to track payments directly against 
individual projects; they must be tracked against invoices and statements in the client’s bill-
ing account. The advantage of this approach is that it allows much more flexibility in terms of 
recording payments - including advance payments/deposits, partial payments, and payments 
covering multiple invoices.
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Viewing billing accounts

To show a client’s billing activity, select the client whose account you wish to view, then click 
the “Billing” tab or choose View > Show Billing Activities.

The billing list appears to the right of the client list, and shows the complete history of the 
client’s financial account, consisting of all saved estimates, invoices, reminders, payments, 



149Chapter 6: Billing

and statements associated with that client (see What are the different types of billing items?, in 
this chapter, for an overview of these). When you select an item in the billing list, a preview of 
that item will appear to the right. Drag the slider at the top of the preview pane to resize the 
preview. You can resize the billing list and preview pane by clicking and dragging the divider 
between them.

NOTE
	 The billing list only shows items pertaining to the selected client(s). If you select 

more than one client (using Command-click), billing items for all of them will be 
displayed.

Each item displays its type and the date on which it was recorded. It may also show an item 
number, due date, status, and/or value, as well as the resulting balance of the client’s account. 
When you select an item, any other items in the list that are associated with that item (such as 
payments associated to an invoice) are highlighted in blue. Double-click an item to view and 
edit its details using the pop-up inspector.

Sorting the billing list

iBiz provides several different options for sorting the billing list. Click the header at the top of 
the list and select one of the following options from the drop-down menu:

Billing Activity by Date Ascending/Descending:•	  Sorts items in the list chronologically 
according to the dates on which they were recorded.
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Billing Activity by Due Date Ascending/Descending:•	  Sorts items in the list chronologi-
cally according to their due dates. Items without due dates (estimates, payments, and 
reminders) are sorted ahead of the others.

Billing Activity by Number Ascending/Descending:•	  Sorts items in the list numerically 
according to their estimate/invoice numbers. Items without numbers (payments and state-
ments) are sorted ahead of the others.

Billing Activity by Amount Ascending/Descending:•	  Sorts items in the list numerically 
according to their values. Items with no value (reminders) are sorted ahead of the others.

NOTE
	 The running balance figures that appear on the right side of the billing list will 

only make sense when the list is sorted according to date, so that the amounts 
and their corresponding balances display in chronological order. iBiz does not 
recalculate the balance figures to match other sorting options.

The billing list can also be filtered to hide some items from view. See How do I filter the billing 
list? (next page) for more information.
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How do I filter the billing list?

To filter out billing items based on their type or status, use the buttons displayed next to the 
“Billing” tab. Click the appropriate button(s) to hide any combination of unpaid, paid, and over-
due invoices, or reminders, estimates, and statements:

Clicking a button once will show only the selected item(s); clicking a second time will deselect 
the button and hide that item. Note that filtering out billing items will not delete them from 
iBiz, only hide them temporarily. You can turn off billing filters at any time by clicking the “All” 
button.

NOTE
	 When filtering billing items, iBiz will display how many items are currently dis-

played out of the total at the bottom of the billing list. When all billing items are 
visible, “No items filtered out” will be displayed.
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What are the different types of billing items?

iBiz tracks several different types of items in each of your clients’ billing accounts. Below is a 
brief overview of the different types: click on any type to view more detailed information about 
working with items of that type.

Estimate: A quote sent to a client before any work was performed on a project. 
Estimates display their value in the billing list but do not affect the balance of the 
client’s account.

Invoice: A bill sent to a client for work you performed. When overdue, the icon will 
change (see below) and the amount due will show in red text along with the number 
of days the invoice is overdue. Earnings from invoices increase the balance of the 
client’s account.

Reminder: A copy of an invoice that was resent to the client with a watermark to 
provide additional information or remind the client that payment is due. Reminders 
have no value and do not affect the balance of the client’s account.

Payment: A record of money received from the client for work performed (or to 
be performed, in the case of deposits). Payments can be allocated to invoices and 
statements so that iBiz recognizes the association between individual fees and the 
funds received for them. Payments decrease the balance of the client’s account.
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Statement: A document showing the client’s billing account status, including 
details of invoices (and other statements) sent, payments received, and the cur-
rent balance due. When overdue, the icon will change (see below) and the amount 
due will show in red text along with the number of days the statement is overdue. 
Statements may include fees that increase the balance of the client’s account.

Overdue: This is not a type in the same sense as the others above, but this icon will 
appear next to any invoices or statements that are currently overdue.
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How do I use invoices and estimates in billing 
accounts?

Invoices and estimates are used to record the work you perform for a project and notify your 
client of how much money they owe you (or will be expected to owe, in the case of an esti-
mate). These items are not created directly in your clients’ billing accounts; they are generated 
from your projects. After you create an estimate or invoice and deliver it to the client, it is 
saved to the client’s billing account for reference. Select the client and click the “Billing” tab (or 
choose View > Show Billing Activities) to view the billing account.

Identifying invoices and estimates

Invoices appear in the billing list like this:

At the top left is the word “Invoice” followed by the invoice number and status (see below for 
details). Below that, in gray text, is the amount due for the invoice, along with additional infor-
mation based on the item’s status: the due date (if the invoice is open), the word “paid” (if the 
invoice has been paid), or the number of days payment is overdue, in red text (if the invoice is 
overdue). At the top right, in blue text, is the date the invoice was created. Below that, in gray 
text, is the balance of the client’s account after the invoice charges have been factored in.
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NOTE
	 If an invoice is marked “Canceled,” the amount and balance figures are hidden and 

the client’s balance is not adjusted by that invoice. 

Estimates appear in the billing list like this:

At the top left is the word “Estimate” followed by the estimate number. Below that, in gray text, 
is the amount of the estimate. To the right, in blue text, is the date the estimate was created. 
The client’s account balance does not appear because estimates do not affect the balance.

Editing invoices and estimates

Double-click an invoice or estimate in the billing list, then click the “Info” tab to view and edit 
the item’s details using the pop-up inspector:

Date sent:•	  The date the estimate or invoice was originally created. Click the gray arrow  
to have iBiz show the project(s) from which the estimate/invoice was generated.

Due date:•	  The date by which payment is due for the invoice (not applicable to estimates).

Number:•	  The number assigned to the estimate or invoice.

Tax 1:•	  The total amount of Tax 1 applied to the estimate or invoice.

Tax 2:•	  The total amount of Tax 2 applied to the estimate or invoice.
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Amount:•	  The total charges quoted or billed to the client.

Status:•	  The current state of the invoice (not applicable to estimates):

Open:•	  The invoice has been sent to the client but payment has not yet been received 
in full. An open invoice displays its due date in the billing list until that date has 
passed. At that point, the invoice is flagged as “Overdue,” the item’s icon changes to 
a  stop sign, and the number of days by which payment is overdue is displayed in 
red text in the billing list.

Paid:•	  Payment has been received for the invoice and the invoice is now considered 
closed.
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Canceled:•	  The invoice has been closed without receipt of payment. The charges as-
sociated with the invoice are removed from the client’s billing account as payment is 
no longer expected.

Feel free to make any changes necessary, then click “Done” to save them and close the inspec-
tor.

NOTE
	 Changes made in the inspector will not affect the contents of the original invoice 

or estimate; they will only affect the information displayed about that item in the 
billing list.

Managing associated payments

When payments are added to a client’s billing ac-
count, you have the option of allocating those pay-
ments to specific invoices and statements (esti-
mates cannot have payments allocated to them). To 
view and edit the payments that have been allocated 
to an invoice, double-click it to open the pop-up 
inspector, then click the “Payments” tab:

Any payments that have been allocated to the in-
voice will be displayed in the list. To remove a pay-
ment from the list, select it and click the  button 
at the bottom of the list. The payment will lose its 



158 Chapter 6: Billing

association with the current invoice, but will not be deleted from the client’s billing account. 
If you remove all payments from an invoice, its status will change to “Open” when you click 
“Done.” To reallocate payments to the invoice, you will need to edit the payment items directly.

Additional invoice/estimate commands

Select an estimate or invoice in the billing list and click the  button at the bottom of the 
list to access some additional commands:

Add Payment for Selected Invoice:•	  Choose this option to have iBiz automatically add 
a payment to the client’s billing account for the amount of the selected invoice(s). The 
payment will automatically be allocated to the selected invoice(s) and the status of the 
invoice(s) will be changed to “Paid.” This option is not available for estimates.

Add Reminder for Selected Invoice:•	  Choose this option to have iBiz create a reminder 
for the selected invoice (see How do I send reminders to my clients for invoices and state-
ments?, in this chapter, for more info). This option is not available for estimates.

Show Projects:•	  Choose this option to have iBiz display the project(s) from which the se-
lected estimate or invoice was generated.

Send Again:•	  Choose this option to have iBiz create a new message in Apple Mail, ad-
dressed to the client, with a PDF copy of the selected estimate or invoice attached.

Open in Preview:•	  Choose this option to view a PDF copy of the selected estimate or in-
voice with Apple Preview.

Print:•	  Choose this option to print a copy of the selected estimate or invoice.
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Save to PDF:•	  Choose this option to save a copy of the selected estimate or invoice on your 
computer in PDF format.

Export as XML:•	  Choose this option to save a copy of the selected estimate or invoice on 
your computer in XML format.

Deleting estimates and invoices

To delete an estimate or invoice from your client’s billing list, select the item you want to 
remove and click the  button at the bottom of the list. iBiz will ask for confirmation; click 
“Delete” to remove the item from the billing account.

NOTE
	 When you delete an invoice, the charges associated with that invoice are dropped 

from the client’s account and the balance is updated accordingly. Any payments 
that were allocated to the invoice will lose that allocation, but will remain in the 
billing list.



160 Chapter 6: Billing

How do I send reminders to my clients for 
invoices and statements?

Reminders are used for sending a notice to a client about an invoice or statement you sent 
previously. Reminders may be printed with watermarks like “Overdue,” “Please remit payment,” 
or any other text. You can even stamp your reminders with an image of your choosing.

Creating reminders

To create a reminder, select the appropriate client and click on the “Billing” tab or choose View 
> Show Billing Activities. In the billing list, select the invoice or statement for which you want 
to send the reminder, click the  button at the bottom of the list, and choose “Add Remind-
er for Selected Invoice/Statement.” A preview window will open, showing the original invoice or 
statement and some settings for adding a watermark:
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Adding a watermark

The watermark settings are positioned on the right side of the reminder preview window. At 
the top is an editable text field showing the text that will be displayed over top of the original 
invoice or statement. Click the  button to open a floating window that shows the watermark 
text with attributes applied (e.g. bold, font, size, etc.):

Edit the text in the floating window and adjust any of the text attributes using the  Font 
Picker and the  Color Picker. Close the floating window and click the  button to apply 
any changes you made in the floating window to the watermark that appears in the reminder 
preview.

To add an image to the watermark, drag any image file from the Finder onto the image well in 
the Watermark Settings area:  
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The image will be displayed on top of the original invoice or statement contents and the text 
you entered for the watermark. To remove the image, click the small ‘x’ button next to the 
image well.

Adjusting the watermark

Use the following controls to adjust the layout of the watermark on the reminder:

Position:•	  Increase and decrease the X (horizontal) and Y (vertical) position settings to move 
the watermark around on the page. Click the “Center” button to return the watermark to 
the middle of the page (at position 0,0).

Rotate:•	  Click the divot on the  button and drag it around the circle, or change the 
number displayed in the “Angle” field, to rotate the watermark.

Transparency:•	  Drag the slider to the right to make the watermark more opaque, or to the 
left to make the watermark more transparent.

Posting the due date in iCal

Once you are happy with your watermark settings, you can use the iCal Info settings to set 
whether or not you want an event to be created in iCal for the Reminder. For example, you 
could make an event in iCal with an alarm to remind you that you sent the Reminder one week 
ago. This functionality provides great integration between the two program so that you can be 
sure that you always follow up with your clients in timely manner.

If you want to post the reminder’s due date in iCal, check “Add due date to iCal.” The following 
two options will be enabled as a result:
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Calendar:•	  Choose which of your iCal calendars you want the reminder to appear on.

Alarm:•	  If desired, attach an alarm to the iCal event so that iCal will send you an email, dis-
play an alert message, or play a sound to remind you that payment is due. Use the options 
that appear below to configure the selected alarm.

Delivering the reminder

The preview window contains two options for delivering the reminder to the client. Click the 
“Delivery Options” button at the bottom-left corner of the preview window to choose one or 
both of them:

PDF Attachment Using Mail:•	  Choose this option to generate a new message in Apple Mail 
addressed to the client. iBiz will create a PDF copy of your reminder and attach it to the 
email. Mail will open automatically and display your message - enter any additional notes 
and click “Send” to deliver the reminder to the client.

Print:•	  Choose this option to print a copy of the reminder. You can also use the PDF button 
in the Mac OS X print window to save a PDF copy of the reminder on your computer.

Saving the reminder

Click the “Done” button at the bottom-right corner of the preview window to save the reminder 
to the client’s billing account (the account balance will not be affected). To discard the re-
minder without saving, click “Cancel.”

Once you have saved the reminder, it will appear in the billing list like this:
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At the top left is the word “Reminder.” Below that, in gray text, is the date on which the re-
minder was created.

 TIP
	 “Has a Reminder been sent for an invoice or statement?” This is a common ques-

tion that can arise if you are creating lots of invoices for a client. The question is 
easily answered in iBiz: to see the reminders sent for a given invoice or statement, 
simply select it in the billing list. Any reminders that were created for that item 
will be highlighted in blue. Similarly, if you select a reminder, the original invoice 
or statement will be highlighted in blue.

Editing reminders in billing accounts

Double-click a reminder in the billing list, then click the “Info” tab to view and edit the item’s 
details using the pop-up inspector:

Date sent:•	  The date the reminder was created. Click the gray arrow  to have iBiz show 
the project(s) from which the original invoice or statement was generated.

Number:•	  The number assigned to the original invoice or statement from which the re-
minder was created.
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Feel free to make any changes necessary, then click “Done” to save them and close the inspec-
tor.

Additional reminder commands

Select a reminder in the billing list and click the  button at the bottom of the list to access 
some additional commands:

Show Projects:•	  Choose this option to have iBiz display the project(s) from which the se-
lected reminder’s original invoice or statement was generated.
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Send Again:•	  Choose this option to have iBiz create a new message in Apple Mail, ad-
dressed to the client, with a PDF copy of the selected reminder attached.

Open in Preview:•	  Choose this option to view a PDF copy of the selected reminder with 
Apple Preview.

Print:•	  Choose this option to print a copy of the selected reminder.

Save to PDF:•	  Choose this option to save a PDF copy of the selected reminder on your com-
puter.

Deleting reminders

To delete a reminder from your client’s billing list, select the item you want to remove and click 
the  button at the bottom of the list. iBiz will ask for confirmation; click “Delete” to remove 
the reminder from the billing account.
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How do I record payments from my clients?

After performing work for a project, sending an invoice to bill the client for that work, perhaps 
sending a reminder that payment is due, and (in some cases) sending a statement with late 
fees, the last step in a typical billing cycle is to receive payment from the client. iBiz allows you 
to record these payments in your clients’ billing accounts.

Because iBiz takes a client-centered approach to billing, a great deal of flexibility is allowed 
in the way payments are recorded. Your workflow may dictate that you receive payment after 
sending the client an estimate and prior to beginning work on the project (i.e. a deposit). You 
may track retainers for your clients that require you to accept payment up front and deduct 
expenses from that fund, detailing the remainder on your invoices. Or you may simply charge 
your clients for work after it has been performed, send reminders and late fees when neces-
sary, and record payments as you collect them. All of these scenarios can be accommodated by 
entering payment items in your clients’ billing accounts.

Adding payments

To record a payment, select the appropriate client and click the “Billing” tab or choose View > 
Show Billing Activities. Click the  button and choose “Add Payment.” A new payment item 
will be added to the billing list, and the pop-up inspector will open automatically to allow you 
to edit the payment details:
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Amount:•	  Enter the amount of money received from the client here. By default, this field is 
populated with the client’s outstanding balance.

Date:•	  The date on which the payment was created. By default, this field is populated with 
the current date.

Notes:•	  Type in any additional information about the payment that you want to remember 
here.
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Recording the payment in iBank

NOTE
	 If you purchased iBiz from the Mac App Store, iBank integration features are not 

available. The information in this section only applies to the version of iBiz that is 
available for download from the IGG Software website.

If you own a copy of  iBank 3, iBiz makes it easy to record your client’s payments in your 
iBank accounts as well. In the pop-up inspector, look for the section labeled “iBank Options.” 
Check “Put in account” and, using the pop-up menu button, choose which account you want to 
record the payment in. iBank must be running for iBiz to be able to access your financial ac-
counts - click the “Launch iBank” button to open it if necessary.

After you click “Done” to close the inspector window, iBiz will create a new “Deposit” transac-
tion in the iBank account you specified. It will be assigned the same date and amount as the 
payment, with the client’s name as the payee and the notes you entered as the transaction 
memo.

Allocating the payment to invoices and statements

If you need to split a payment across several invoices and/or payments, or simply want to track 
which payments are used to pay for which items, you can allocate your payments to invoices 
and statements using the pop-up inspector. Click the small disclosure triangle next to “Allo-
cate to Invoices” to reveal the allocation table:
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To add a payment allocation:

Click the  button below the table to add a new item, then click in the “Allocate To” column 
to view a pop-up menu of all invoices and statements that are currently open. Choose the item 
you want to allocate the payment to, and the charges currently outstanding for that item will 
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appear in the “Invoice Bal.” column. Double-click in the “Amt. to Apply” column to enter the 
amount you want to allocate to that item from the current payment (amounts should be en-
tered as negative numbers).

Add as many items to the allocation table as necessary. The “Amount remaining” figure below 
the table shows how much of the original payment amount remains to be allocated. It is not 
necessary to allocate the entire payment amount; any remaining funds will still be deducted 
from the client’s account balance, but will not be associated with any particular invoice or 
statement.

 TIP
	 Payment allocations do not need to be entered at the time the payment is initially 

recorded. If the payment represents a deposit, for example, and an invoice is sent 
after the payment has been recorded, you can go back and edit the payment to 
allocate it to the invoice later on.

To remove a payment allocation:

Select the item in the allocation table you want to remove and click the  button. Alterna-
tively, you can double-click on the associated invoice or statement in the billing list, click the 
“Payments” tab, and remove the allocation from that table.
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Saving the payment

Once you are done editing the payment details, click “Done” to save the payment to the client’s 
billing account and update the account balance accordingly. The payment will appear in the 
billing list like this:

At the top left is the word “Payment.” Below that, in gray text, is the payment amount. At the 
top right, in blue text, is the date the payment was recorded. Below that, in gray text, is the 
balance of the client’s account after the payment has been factored in.

You may double-click a payment at any time to open the pop-up inspector and edit the pay-
ment details as needed.

Deleting payments

To delete a payment from your client’s billing list, select the payment you want to remove and 
click the  button at the bottom of the list. iBiz will ask for confirmation; click “Delete” to 
remove the payment from the billing account.
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NOTE
	 When you delete a payment, the credits associated with that item are dropped 

from the client’s account and the balance is updated accordingly. Any invoices 
and/or statements to which the payment was allocated will lose that allocation, 
but will remain in the billing list.
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How do I send account statements to my clients?

Statements can be generated and sent to your clients to show them the details of their billing 
accounts, including invoices (and other statements) sent, payments received, and any remain-
ing balance due. Statements can have fees (flat or percentage-based) associated with them if, 
for example, you wish to charge a customer for overdue payments.

Generating statements

To create a new statement, select the client for whom you want to generate the statement and 
click the “Billing” tab or choose View > Show Billing Activities. Click the  button at the bot-
tom of the billing list and choose “Add Statement.” A sheet will appear to let you choose what 
information will appear on the statement.
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To manually select billing 
items to include:

Check off the invoices, pay-
ments, and other statements 
you want to appear on the 
new statement. Be sure to 
leave the “Report on activi-
ties between dates” option 
unchecked.
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To include all billing items 
within a certain date range:

Check “Report on activities 
between dates,” then type 
in the starting and ending 
date for the range you want 
to include. By using the date 
range option, it is easy to 
send a customer a monthly 
statement so that they can 
see where they stand with 
you financially.
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NOTE
	 When you include other statements on a new statement, the value of those state-

ments is based solely on their fees (the balances reported on those statements are 
not counted).

To add a fee to the statement:

If you want to charge the client a fee for late payment, you can add one to the statement by 
checking “Add late fee.” Choose one of the following options:

% based:•	  Choose this option and enter a percentage to have iBiz automatically calculate 
the fee as a percent of the total amount outstanding on the client’s account.

flat rate:•	  Choose this option and enter an amount to add a fixed fee to the statement.

To choose which template to use for the statement:

Select a template from the pop-up menu button labeled “Statement Template.” Click “Make 
Statement” to proceed.

Previewing the statement

After telling iBiz to generate the statement, a preview window will appear. The yellow and black 
stripes across the top of the window are there to remind you that the statement has not yet 
been saved to the client’s billing account. Review the statement contents to make sure all the 
information is correct. If you need to make any changes to the contents of the statement, you 
can make them directly in the preview window (RTF templates only - HTML templates require 
you to cancel the preview and start over).
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Along the right side of the window you will find some additional options pertaining to the 
statement:

Client:•	  The name of the client for whom the statement has been generated.

Due date:•	  The date by which payment is expected for this statement. If you want to post a 
reminder for this due date in iCal, check “Add due date to iCal.” The following two options 
will be enabled as a result:

Calendar:•	  Choose which of your iCal calendars you want the reminder to appear on.

Alarm:•	  If desired, attach an alarm to the iCal event so that iCal will send you an 
email, display an alert message, or play a sound to remind you that payment is due. 
Use the options that appear below to configure the selected alarm.

 TIP
	 By default, statement due dates are set to 30 days after the statement creation 

date. To change this default setting, go to iBiz > Preferences, click the  Ad-
vanced button, and change the “Invoices due after” setting.

Delivering the statement

The preview window contains two options for delivering the statement to the client. Click the 
“Delivery Options” button at the bottom-left corner of the preview window to choose one or 
both of them:

PDF Attachment Using Mail:•	  Choose this option to generate a new message in Apple Mail 
addressed to the client. iBiz will create a PDF copy of your statement and attach it to the 
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email. Mail will open automatically and display your message - enter any additional notes 
and click “Send” to deliver the statement to the client.

Print:•	  Choose this option to print a copy of the statement. You can also use the PDF button 
in the Mac OS X print window to save a PDF copy of the statement on your computer.

Saving the statement

Click the “Done” button at the bottom-right corner of the preview window to save the state-
ment to the client’s billing account and update the account balance accordingly (only if a fee 
was applied). To discard the statement without saving, click “Cancel” - the client’s billing ac-
count will not be affected.

Once you have saved the statement, it will appear in the billing list like this:

At the top left is the word “Statement” followed by the statement’s status (see below for 
details). Below that, in gray text, is the amount of the statement fee, along with additional 
information based on the item’s status: the due date (if the statement is open), the word “paid” 
(if the statement fee has been paid), or the number of days payment is overdue, in red text (if 
the statement is overdue). At the top right, in blue text, is the date the statement was created. 
Below that, in gray text, is the balance of the client’s account after the statement fee has been 
factored in.
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NOTE
	 If a statement is marked “Canceled,” the amount and balance figures are hidden 

and the client’s balance is not adjusted by that statement. 

Editing statements in billing accounts

Double-click a statement in the billing list, then click the “Info” tab to view and edit the item’s 
details using the pop-up inspector:

Date sent: The date the statement was created.•	
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Due date:•	  The date by which payment is due for the balance shown on the statement.

Amount:•	  The amount of the fee billed to the client on this statement.

Status:•	  The current state of the statement (only available if a fee was applied to the state-
ment):

Open:•	  The statement has been sent to the client but payment for the statement fee 
has not yet been received in full. An open statement displays its due date in the bill-
ing list until that date has passed. At that point, the statement is flagged as “Over-
due,” the item’s icon changes to a  stop sign, and the number of days by which 
payment is overdue is displayed in red text in the billing list.

Paid:•	  Payment has been received for the statement fee and the statement is now 
considered closed.

Canceled:•	  The statement has been closed without receipt of payment. The fee associ-
ated with the statement is removed from the client’s billing account as payment is no 
longer expected.

Feel free to make any changes necessary, then click “Done” to save them and close the inspec-
tor.

Managing associated payments

When payments are added to a client’s billing account, you have the option of allocating those 
payments to specific invoices and statements. To view and edit the payments that have been 
allocated to a statement, double-click it to open the pop-up inspector, then click the “Pay-
ments” tab:
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Any payments that have been allocated to the 
statement will be displayed in the list. To remove a 
payment from the list, select it and click the button 
at the bottom of the list. The payment will lose its 
association with the current statement, but will not 
be deleted from the client’s billing account. If you 
remove all payments from a statement, its status 
will change to “Open” when you click “Done.” To 
reallocate payments to the statement, you will need 
to edit the payment items directly. 

Additional statement commands

Select a statement in the billing list and click the  button at the bottom of the list to access 
some additional commands:

Add Payment for Selected Statement:•	  Choose this option to have iBiz automatically add 
a payment to the client’s billing account for the amount of the selected statement(s). The 
payment will automatically be allocated to the selected statement(s) and the status of the 
statement(s) will be changed to “Paid.”

Add Reminder for Selected Statement:•	  Choose this option to have iBiz create a reminder 
for the selected statement (see How do I send reminders to my clients for invoices and 
statements?, in this chapter, for more info).
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Show Projects:•	  Choose this option to have iBiz display the project(s) associated with all 
invoices that were included in the statement.

Send Again:•	  Choose this option to have iBiz create a new message in Apple Mail, ad-
dressed to the client, with a PDF copy of the selected statement attached.

Open in Preview:•	  Choose this option to view a PDF copy of the selected statement with 
Apple Preview.

Print:•	  Choose this option to print a copy of the selected statement.

Save to PDF:•	  Choose this option to save a copy of the selected statement on your com-
puter in PDF format.

Export as XML:•	  Choose this option to save a copy of the selected statement on your com-
puter in XML format.

Deleting statements

To delete a statement from your client’s billing list, select the statement you want to remove 
and click the  button at the bottom of the list. iBiz will ask for confirmation; click “Delete” 
to remove the statement from the billing account.

NOTE
	 When you delete a statement with a fee applied, the charges associated with that 

statement are dropped from the client’s account and the balance is updated ac-
cordingly. Any payments that were allocated to the statement will lose that alloca-
tion, but will remain in the billing list.
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What are reports all about?

 
Reports allow you to quickly summarize information about your clients, projects, job events, 
and billing activities. You can compare project earnings, see how your time is distributed 
among job events, or prepare statements for your accountant - even organize your records 
for tax time! Reports in iBiz are generated directly from the client list. Because reports are 
designed to be dynamic and customizable, they are not stored anywhere within iBiz, but can be 
exported for your own records or for use with other programs.
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How do I generate a report?

The first step in creating a report is to select the client(s) you want to include in the report. To 
include all clients, simply click the “All Clients” item in the client list; otherwise, Command-

click to select only those clients you want to include. Next, click the Report button on 
the toolbar or choose Client > Make Report. A sheet will appear displaying each of the selected 
clients and their associated projects.

NOTE
	 If you currently have filters applied to your project list, they will be applied to 

the report as well. To make sure all projects are available for your report, choose 
Project > Show All Projects before generating the report.
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Choosing projects for the report

Check individual projects to mark them 
for inclusion in the report. Click the 
small disclosure triangle next to a client 
to hide or show its associated projects; 
checking a client will mark its associ-
ated projects as well. Clicking “Check/
Uncheck All” will mark all clients and 
projects displayed in the list. You can 
also use the “Check Selected” button to 
mark the clients and projects you cur-
rently have selected in the list.
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Excluding job events based on a date range

If you want to exclude certain job events from the report based on their dates, check “Only 
report on job events between” and enter a start and end date. Any job events that fall outside 
that range will not be included in the report.

NOTE
	 This feature does not cause iBiz to exclude projects in their entirety. If you 

checked a project to include it in the report, but the project does not have any job 
events within the date range specified, the project will still appear on the report - 
it will simply have no job events or earnings.

Choosing a template

Select a template from the pop-up menu button labeled “Report Templates.” The template you 
choose here will be used for the “Summary” report; you will be able to choose a different tem-
plate for this report later on, if necessary. Click “Generate Report” to proceed.
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How do I read the various reports?

Once you have generated a report, the report window will appear with four different tabs: Sum-
mary, Clients, Projects, and Job Events. Each one of these tabs contains a different report; click 
on the want you want to view:

Summary
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This tab displays textual reports generated from your installed templates. Because of the flex-
ibility of report templates, the summary report can be used to show anything from mileage 
statistics to client balances, timer logs and expense totals. By default, the template you se-
lected during the report setup is shown. To change the template, choose one using the pop-up 
menu button labeled “Template,” and the report will update accordingly.

To save a PDF copy of the summary report, click “Save as PDF,” enter a name for the file, 
choose a location to save it in, and click “Save.”
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Clients

This tab displays two pie charts and a data table with information pertaining to your clients:
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Client earnings

This pie chart shows a breakdown of earnings per client, with each slice of the pie representing 
the earnings from a particular client relative to the other clients included in the report. Click a 
pie slice to enlarge it and show the name, value of earnings, and percent of total earnings for 
the client represented by that slice. The total earnings are displayed at the top of the chart.

Client time

This pie chart shows a breakdown of time per client, with each slice of the pie representing the 
time recorded on all the timed job events belonging to a particular client, relative to the other 
clients included in the report. Click a pie slice to enlarge it and show the name, time logged, 
and percent of total time for the client represented by that slice. The total time is displayed at 
the top of the chart.

Data table

Under the charts is a table summarizing project information for each client included in the 
report. Click any column header to sort the table according to the information in that column; 
click a second time to reverse the direction of the sort. Click and drag the small divot in the 
divider between the data table and the charts to resize the table and charts.

Client:•	  The name of the client.

# Projects:•	  The number of projects included in the report for the specified client.

Time:•	  The total time recorded in the client’s timed job events.

Expenses:•	  The total value of the client’s job events that are flagged as expenses.
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Gross:•	  The total earnings from the client’s projects, including any markup applied to their 
job events.

Discount:•	  The total value of percentage discounts applied to the client’s projects.

Deductions:•	  The total value of deductions applied to the client’s projects.

Tax 1:•	  The total value of Tax 1 applied to the client’s job events.

Tax 2:•	  The total value of Tax 2 applied to the client’s job events.

Net:•	  The total earnings from the client’s projects after discounts, deductions, and taxes 
have been applied.

Net/Project:•	  The net earnings averaged across the number of projects included in the 
report for the specified client.
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Projects

This tab displays two pie charts and a data table with information pertaining to your projects:



199Chapter 7: Reports

Project earnings

This pie chart shows a breakdown of earnings per project, with each slice of the pie represent-
ing the earnings from a particular project relative to the other projects included in the report. 
Click a pie slice to enlarge it and show the name, value of earnings, and percent of total earn-
ings for the project represented by that slice. The total earnings are displayed at the top of the 
chart.

Project time

This pie chart shows a breakdown of time per project, with each slice of the pie representing 
the time recorded on all the timed job events belonging to a particular project, relative to the 
other projects included in the report. Click a pie slice to enlarge it and show the name, time 
logged, and percent of total time for the project represented by that slice. The total time is 
displayed at the top of the chart.

Data table

Under the charts is a table summarizing information about each project included in the report. 
Click any column header to sort the table according to the information in that column; click a 
second time to reverse the direction of the sort. Click and drag the small divot in the divider 
between the data table and the charts to resize the table and charts.

Project:•	  The name of the project.

#:•	  The number assigned to the specified project.

Time:•	  The total time recorded in the project’s timed job events.

Expenses:•	  The total value of the project’s job events that are flagged as expenses.
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Gross:•	  The project’s total earnings, including any markup applied to their job events.

Discount:•	  The total value of percentage discounts applied to the projects.

Deductions:•	  The total value of deductions applied to the projects.

Tax 1:•	  The total value of Tax 1 applied to the project’s job events.

Tax 2:•	  The total value of Tax 2 applied to the project’s job events.

Net:•	  The project’s total earnings after discounts, deductions, and taxes have been applied.

Net/Event:•	  The net earnings averaged across the number of job events contained within 
the specified project.
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Job Events

This tab displays two pie charts and a data table with information pertaining to your job 
events:
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Job event earnings

This pie chart shows a breakdown of earnings per job event, with each slice of the pie repre-
senting the earnings from a particular job event relative to the other job events included in the 
report. Click a pie slice to enlarge it and show the name, value of earnings, and percent of total 
earnings for the job event represented by that slice. The total earnings are displayed at the top 
of the chart. Click and drag the slider labeled “Number of slices” to adjust how many slices are 
displayed in the pie chart - the slices with the highest value will be displayed, and remaining 
slices will be combined into a single slice labeled “Other.”

Job event time

This pie chart shows a breakdown of time per job event, with each slice of the pie representing 
the time recorded by a particular timed event relative to the other timed events included in the 
report (non-timed job events are not represented in this chart). Click a pie slice to enlarge it 
and show the name, time logged, and percent of total time for the job event represented by 
that slice. The total time is displayed at the top of the chart. Click and drag the slider labeled 
“Number of slices” to adjust how many slices are displayed in the pie chart - the slices with the 
longest time will be displayed, and remaining slices will be combined into a single slice labeled 
“Other.”

Data table

Under the charts is a table summarizing information about each job event included in the 
report. Click any column header to sort the table according to the information in that column; 
click a second time to reverse the direction of the sort. Click and drag the small divot in the 
divider between the data table and the charts to resize the table and charts.
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Name:•	  The name of the job event.

Time:•	  The time recorded for the specified job event (or “NA” if it is not a timed event).

Rate:•	  The hourly rate, flat fee, cost per item, or charge per mile/kilometer entered for the 
job event (depending on the job event’s type). When consolidating job events, the average 
rate is displayed here.

Earnings:•	  The job event’s earnings, including any markup applied.

Tax 1:•	  The value of Tax 1 applied to the job event.

Tax 2:•	  The value of Tax 2 applied to the job event.

Notes:•	  Additional comments or information entered for the job event. When consolidating 
job events, the word “consolidated” appears here for any items that represent multiple job 
events.

 TIP
	 To make the job event table more manageable when a large number of events are 

showing, check “Consolidate job events of same name and type.” Any job events 
that share the same name, type, and “taxable” status will be merged into a single 
item and treated as one job event in both charts and the data table.



204 Chapter 7: Reports

How do I save reports?

Reports in iBiz are designed to be dynamic and flexible; as a result, you cannot save or store 
reports in iBiz. You can export the data from your reports, however, to keep a record for your-
self or to analyze the data further with another program.

Exporting report data

Regardless of which report you are currently viewing, click the “Export” button in the bottom-
left corner of the window and choose one of the following options in the window that appears:

Export summary data as text:•	  Choose 
this option to save the data from the sum-
mary report to a text file.

Export data from tables:•	  Choose this 
option to save the information in the data 
tables from the client, project, and/or job 
event reports to a tab-delimited text file. 
Check each report whose data you want to 
include in the text file.
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Once you have chosen the data you want to export, enter a name for the new file and choose a 
location to save it in, then click “Save.”

 TIP
	 You can also export the summary report to a PDF file by clicking the “Summary” 

tab in the report window, then clicking the “Save as PDF” button. 
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How do I customize my summary reports?

Summary reports are generated using your installed templates. iBiz comes with several 
professionally-designed templates already installed, so that you can start using the reporting 
features right away. It also includes a full-featured template editor to allow you to customize 
your report templates to meet your specific needs. For more information, see Chapter 8: Tem-
plates (next).
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What are templates all about?

iBiz uses a flexible template system to allow you to customize your estimates, invoices, state-
ments, and reports. Several professionally-designed templates are included with the software 
to help you get started quickly, but your business may require that you make adjustments to 
include more information, hide some details, or use a different layout. Once you get the hang 
of editing templates, you can even design your own templates from scratch to meet your exact 
needs.

To view your installed templates, click  Templates on the toolbar or choose Billing > 
Show Invoice/Report Templates. For more information about working with templates in this 
window, see How do I manage my installed templates? (next section).

Templates are based around the use of tags, which are essentially placeholders that you can 
insert into your templates. When you generate an estimate, invoice, statement, or report, iBiz 
replaces the tags with real data. For more information about how templates work, see How do I 
get started with template editing? in this chapter.

Template types

iBiz distinguishes among three main types of templates:

Invoice•	 : These templates are used for generating invoices and estimates. To use them, 
select a client, click the “Projects” tab, select a project, and click the  button at the 
bottom of the project list. RTF and HTML styles are supported for invoice templates.
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Statement:•	  These templates are used for generating statements. To use them, select a cli-
ent, click the “Billing” tab, click the  button at the bottom of the billing list, and choose 
“Add Statement.” RTF and HTML styles are supported for statement templates.

Report:•	  These templates are used for generating custom reports that appear under the 
“Summary” tab in the reports window. To use them, select one or more clients and click 

the Report button on the toolbar. Only the RTF style is supported for report tem-
plates.

Template styles

iBiz offers two different file formats that you may use to design your templates: RTF and HTML. 
It is worth noting the relative advantages and disadvantages of the two styles:

RTF:•	  This style is very simple to use, particularly for users who are familiar with TextEdit. 
Templates produced with this style use a “what you see is what you get” approach, so that 
the end result is very similar to how the template looks as you are editing it. Drawbacks to 
using the RTF style include the lack of support for page headers and footers, page num-
bers, and tables, and limited support for images.

HTML:•	  This style is more difficult to use, as it requires a working knowledge of HTML and 
CSS, but allows much greater flexibility and control over layout than the RTF style. Tem-
plates produced with this style are written in HTML code and must be “previewed” in order 
to see what the final result will look like, so you cannot see your changes in real time. 
Advantages to using the HTML style are numerous, but the learning curve can be steep for 
those who are not already seasoned web designers.
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How do I manage my installed templates?

Estimates, invoices, statements, and reports are generated using templates. To view and edit 
the templates you currently have installed, open the template editor by clicking the  

Templates button on the toolbar or choosing Billing > Show Invoice/Report Templates:

Your templates are listed along 
the left side of the template 
window, each one with its 
name, style, and type. Clicking 
a template will display a pre-
view of that template to the 
right, which you can zoom in or 
out using the “Zoom” slider at 
the bottom of the window. If 
you want to edit a template, 
click the “Edit” button at the 
bottom right corner.
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Adding templates

To add a new template, click the “+ Template” button at the bottom of the list. The template 
picker will appear with a number of options to choose from:

First, select a template type (Invoice, Statement, or Report) from the list on the left. The op-
tions shown on the right side of the window will change depending on your selection. Click on 
the template you want to use: choose any of the pre-designed options or, if you want to design 
your own template, choose one of the options named “Blank.” When you have selected the 
template you want, click “Choose” to proceed.
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A new template will appear in the template editor list based on the option you chose. You can 
now close the template editor and use the template as-is, or edit the template to better suit 
your needs.

NOTE
	 When you create a new template, your company information is filled in automati-

cally. Changing your company details and/or logo in iBiz preferences will not au-
tomatically update your existing templates. To ensure that your templates reflect 
these changes, you must either edit the templates manually or delete and recreate 
them using the template picker.

Organizing templates

The order in which your templates appear in the template editor list is the same order in which 
they are displayed when you are required to choose one for generating an estimate/invoice, 
statement, or report. You can arrange your templates in this list however you like: simply drag 
and drop items in the list to change their positions.

 TIP
	 The first nine invoice templates displayed in the list are automatically assigned 

hotkeys so that you can quickly use them to create estimates and invoices. To 
view these hotkey assignments, click the “Project” tab in the main iBiz window and 
then click the  button at the bottom of the project list.
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Deleting templates

To remove a template from the list, select it and click the “- Delete” button at the bottom of 
the template editor. iBiz will ask you to confirm the action before permanently deleting the 
template.

Restoring the default templates

If you want to add all of the default invoice, statement, or report templates back to the list 
quickly, click the  button at the bottom of the template editor and choose the set you wish 
to add. If you have a template with the same name as one of the defaults, iBiz will not load that 
template from the default set.
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How do I get started with template editing?

Although template editing may be intimidating at first glance, mastering the basics is actually 
quite a simple matter. For many users, all you will ever need to do is take one of our pre-de-
signed templates and make some minor modifications, which can literally be done in seconds 
once you know how. For users with more specific needs, custom-made HTML templates offer 
a huge amount of flexibility, and those with advanced knowledge of HTML and CSS can tweak 
them down to the smallest detail.

This section will review the basic concepts of template editing, beginning with the most simple 
and getting progressively more complex.

Using the template editor

The first step in editing any template is opening it with the template editor. Click the  

Templates button on the toolbar, or choosing Billing > Show Invoice/Report Templates, 
and select a template from the list. Click the “Edit” button in the bottom right corner of the 
template window to open the template for editing. Yellow and black stripes will appear at the 
top of the editing pane to remind you that you are currently editing the template. You can 
change the name of the template at the top of this pane. If it is an RTF template, the editor 
displays the text of the template; if it is an HTML template, you will see the HTML code.
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Make any changes necessary directly in the template editor. If desired, you can also copy/paste 
the template contents into another program for editing, then copy/paste the revised contents 
back into the iBiz template editor when you are finished.

To preview changes:

Click the “Preview” button at the bottom left side of the editing pane. iBiz will show you a 
preview of what your template will look like with some sample data filled in. If you notice that 
some data is missing, check your template for typos and structural errors.

To save changes:

Click the “Commit Changes” button at the bottom right of the template window. iBiz will per-
manently save the changes you made to the template.

To discard changes:

Click the “Cancel Editing” button at the bottom of the window. iBiz will throw away the changes 
you made and revert the template to its previously saved state.

About tags

The second step in understanding template editing is knowing how to use “tags” appropriately. 
Regardless of whether you compose templates in RTF or HTML style, tags are used to automat-
ically insert data about your clients, projects, job events, and billing accounts. Tags are text 
commands included in the templates that provide special instructions to iBiz. They are always 
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enclosed in brackets (e.g. [CLIENT NAME]) and act as placeholders for information that will be 
drawn from your iBiz data.

Each unique tag corresponds to a specific piece of information. When you generate an es-
timate, invoice, statement, or report based on your template, iBiz looks up the information 
requested by each tag and places it in the template. Any formatting that was applied to the tag 
(including size, font, style, color, spacing, alignment, tabs, etc.) will be applied to the informa-
tion taking its place.

To illustrate, suppose you draft a template that looks like this:

Invoice #: [INVOICE NO.] 

Date: [TODAY SHORT] 

 

[CLIENT COMPANY] 

[CLIENT STREET] 

[CLIENT CITY], [CLIENT STATE]  [CLIENT ZIP]

NOTE
	 This example and the others below are based on the RTF style; if you are work-

ing with HTML templates, consider the examples as if they reflected the rendered 
output of your HTML code.

When used to generate an invoice, the output looks like this:
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Invoice #: 103 

Date: 8/15/06 

 

Some Big Corporation 

123 Main St. 

Pleasantville, UT  55555

Tags can be used to include a wide variety of information in your templates. See What tags 
are available for use on my templates?, in this chapter, for a complete listing of tags and their 
definitions.

 TIP
	 For a quick tag reference while you are editing a template, click the “Tags” but-

ton at the bottom of the template editor. A drawer will appear to one side of the 
window containing a list of tags that you can drag and drop directly onto your 
templates.

About sections

Templates are broken into “sections” in order to accommodate the hierarchy upon which iBiz 
relies. These sections are demarcated by tags that start with “$BEGIN” and “$END” (for details, 
see What tags are available for use on my templates? in this chapter). The following sections 
are available for use:

Client:•	  Contains information about the selected clients (for use on report templates only).



222 Chapter 8: Templates

Project:•	  Contains information about the selected projects (not for use on statement tem-
plates).

Employee:•	  Contains information about employees who ran timers on job events in the 
selected project (not for use on statement templates).

Job event:•	  Contains information about job events in the selected projects (not for use on 
statement templates).

Flat rate event:•	  Contains information about flat rate and quantity job events in the select-
ed projects. When included, this section will separate out job events of these types from 
the main job event section (not for use on statement templates).

Expense:•	  Contains information about job events that are flagged as expenses in the se-
lected projects. When included, this section will separate out job events of this type from 
the main job event section (not for use on statement templates).

Non-billable event:•	  Contains information about job events that are flagged as non-
billable in the selected projects. When included, this section will separate out job events of 
this type from the main job event section (not for use on statement templates).

Employee log:•	  Contains information from timer logs associated with the job events in the 
selected projects (not for use on statement templates).

Account activity:•	  Contains information about invoices, payments, and statements in the 
selected client’s billing account (not for use on invoice templates).

Unlike regular tags, section tags are not replaced with data when you generate an estimate, 
invoice, statement, or report; they are simply removed. Their main function is to demarcate 
the different sections of the template. Any information contained between [$BEGIN] and [$END] 
tags is repeated for each item contained within that section.
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For example, everything that appears on a template between [$BEGIN JOB EVENT LINE] and 
[$END JOB EVENT LINE] will repeat once for each job event selected for inclusion in the esti-
mate, invoice, or report you generate with that template. The employee section will repeat for 
every employee that contributed time to the project being invoiced. This repetition prevents 
you from having to enter the same information multiple times on a template.

By way of illustration, let’s say you want to create a template that displays the project name 
and number for three projects. You will need to use the [PROJECT NAME] and [PROJECT NO.] 
tags, but if you simply place these on a template by themselves...

Project name:  [PROJECT NAME] 

Project number: [PROJECT NO.]

...the resulting form will only display the name and number of the first project selected, not all 
of them:

Project name:  A Preview Project 

Project number: 001

To make sure the tags are repeated for each of the three projects, surround them with the 
[$BEGIN PROJECT LINE] and [$END PROJECT LINE] tags:
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[$BEGIN PROJECT LINE] 

Project name:  [PROJECT NAME] 

Project number: [PROJECT NO.] 

[$END PROJECT LINE]

This will result in the following output:

Project name:  A Preview Project  

Project number: 001  

Project name:  Another Project  

Project number: 002 

Project name:  One More Project  

Project number: 003

NOTE
	 Not all section tags must be used on every template; it is only important to in-

clude them if the template will be used to generate information on more than one 
of the item specified.

If you are in the habit of invoicing only one project at a time, there is no need to include the 
[$BEGIN PROJECT LINE] and [$END PROJECT LINE] tags on your invoice template. Any project 
tags present will display information for the lone project you are invoicing. It is very rare, how-
ever, that you will only want information on a single job event from a project, so most of your 
invoice templates will include [$BEGIN JOB EVENT LINE] and [$END JOB EVENT LINE].
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Template hierarchy

Section tags also follow rules of hierarchy similar to the basic iBiz hierarchy (Client > Project > 
Job Event). This means that on your templates, the job event section should be nested inside 
the project section, and the project section should be nested inside the client section (indenta-
tion has been added here for illustrative purposes and is not required):

[$BEGIN CLIENT LINE] 

	 [$BEGIN PROJECT LINE] 

		  [$BEGIN JOB EVENT LINE] 

		  [$END JOB EVENT LINE]| 

	 [$END PROJECT LINE] 

[$END CLIENT LINE]

Nested section tags will repeat just as tags do – for example, if we add a tag to our code...

[$BEGIN CLIENT LINE] 

	 [$BEGIN PROJECT LINE] 

		  [$BEGIN JOB EVENT LINE] 

			   [NAME] 

		  [$END JOB EVENT LINE] 

	 [$END PROJECT LINE] 

[$END CLIENT LINE]
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...this template will produce a list of the names of all included job events for every selected 
project and client. The list will begin with the first job event in the first project for the first 
client, run through all job events in that project, then move on to the next project. After going 
through all job events in all projects for the first client, it will begin on the next client. This will 
continue until the list ends with the last job event in the last project for the last client.

Don’t forget, however, that there are more sections available than just clients, projects, and job 
events. The complete hierarchy for tag lines is as follows:

[$BEGIN CLIENT LINE] 

 

	 [$BEGIN PROJECT LINE] 

 

		  [$BEGIN EMPL. LINE] 

		  [$END EMPL. LINE] 

 

		  [$BEGIN JOB EVENT LINE] 

 

			   [$BEGIN EMPL. LOG LINE] 

			   [$END EMPL. LOG LINE] 

 

		  [$END JOB EVENT LINE] 

 

		  [$BEGIN FLAT RATE LINE] 

		  [$END FLAT RATE LINE] 

		  ...
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		  ... 

		  [$BEGIN EXPENSE LINE] 

		  [$END EXPENSE LINE] 

		   

		  [$BEGIN NONBILLABLE LINE] 

		  [$END NONBILLABLE LINE] 

 

	 [$END PROJECT LINE] 

	  

	 [$BEGIN ACCOUNT ACTIVITY LINE] 

	 [$END ACCOUNT ACTIVITY LINE] 

 

[$END CLIENT LINE]

NOTE
	 Not all section tags must be used on every template, but any section tags that are 

used should follow the hierarchy outlined above. If the flat rate, expense, and/or 
nonbillable sections are not included, the job event section will include informa-
tion about all job events in the selected projects.

Single-project vs. multi-project templates

Several of the default invoice templates included with iBiz are designed for use with only one 
project at a time. If you are in the habit of billing multiple projects on the same invoice, you 



228 Chapter 8: Templates

will need to make sure that your invoice template is properly structured to accommodate mul-
tiple projects:

The template must have a defined project section: be sure to place 1.	 [$BEGIN PROJECT LINE] 
and [$END PROJECT LINE] tags on your template. All other project-level tags must be placed 
between these two tags in order to work properly.

Remember that the content within the project section will be repeated for each project 2.	
included on the invoice. Design your content so that it looks presentable when the project 
section is repeated multiple times.

Add client-level tags to present the invoice totals. These may include 3.	 [CL. TOTAL AMOUNT] 
and [CL. FINAL BALANCE], and should be placed outside of the project section (they will not 
work properly inside it).
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How does iBiz calculate its figures during the 
billing process?

When composing templates to use for your invoices and reports, it is important to understand 
the process that iBiz uses when calculating billing-related figures. There is a specific order of 
operations that iBiz follows, and there are tags available for presenting information at each 
step.

Single-project templates

The following process illustrates how totals are calculated for invoices and reports at the proj-
ect level:

Gross earnings1.	

This is the starting point for calculating all billing-related totals at the project level. [GROSS 
TOTAL] is used to display this figure, which represents the combined total of all fees for the 
project’s job events, including markup but excluding all other adjustments.

Discounts2.	

Percentage discounts are deducted from the gross earnings before any other adjustments 
are applied. [DISCOUNT AMOUNT] is used to display the amount being deducted, and [TTL 
AFTER DISCOUNT] is used to display the resulting figure.
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Deductions3.	

Flat rate deductions are applied after percentage discounts. [DEDUCTIONS TOTAL] is used 
to display the amount being deducted, and [TTL AFTER DED.] is used to display the result-
ing figure.

Taxes4.	

Taxes are added after flat rate deductions are applied. [TOTAL TAX] is used to display the 
amount being added, and [TOTAL AMOUNT] is used to display the resulting figure, which is 
the project’s Net Earnings.

Outstanding balance5.	

Once the net earnings have been calculated, any balance currently outstanding on the 
client’s billing account is deducted (or added, in the case of a deposit). [UNPAID BALANCE] 
is used to display the amount being deducted or added, and [FINAL BALANCE] is used to 
display the resulting figure, which is the client’s Balance Due.

Multiple-project, single-client templates

The following process illustrates how totals are calculated for invoices and reports at the client 
level:
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Gross earnings1.	

This is the starting point for calculating all billing-related totals at the client level. [CL. 
GROSS] is used to display this figure, which represents the combined total of all fees for the 
client’s job events, including markup but excluding all other adjustments.

Discounts2.	

Percentage discounts are deducted from the gross earnings before any other adjustments 
are applied. [CL. DISCOUNT AMOUNT] is used to display the amount being deducted, and 
[CL. TTL AFTER DISCOUNT] is used to display the resulting figure.

Deductions3.	

Flat rate deductions are applied after percentage discounts. [CL. DEDUCTIONS] is used to 
display the amount being deducted, and [CL. TTL AFTER DED.] is used to display the result-
ing figure.

Taxes4.	

Taxes are added after flat rate deductions are applied. [CL. TOTAL TAX] is used to display 
the amount being added, and [CL. TOTAL] is used to display the resulting figure, which is 
the client’s Net Earnings.

Outstanding balance5.	

Once the net earnings have been calculated, any balance currently outstanding on the cli-
ent’s billing account is deducted (or added, in the case of a deposit). [CL. UNPAID BALANCE] 
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is used to display the amount being deducted or added, and [CL. FINAL BALANCE] is used 
to display the resulting figure, which is the client’s Balance Due.

Multiple-client templates

The following process illustrates how totals are calculated for reports at the summary level:

Gross earnings1.	

This is the starting point for calculating all billing-related totals at the summary level. [SUM 
GROSS] is used to display this figure, which represents the combined total of all fees for all 
clients’ job events, including markup but excluding all other adjustments.

Discounts2.	

Percentage discounts are deducted from the gross earnings before any other adjustments 
are applied. [SUM DISCOUNT AMOUNT] is used to display the amount being deducted, and 
[SUM TTL AFTER DISCOUNT] is used to display the resulting figure.

Deductions3.	

Flat rate deductions are applied after percentage discounts. [SUM DEDUCTIONS] is used 
to display the amount being deducted, and [SUM TTL AFTER DED.] is used to display the 
resulting figure.
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Taxes4.	

Taxes are added after flat rate deductions are applied. [SUM TAX] is used to display the 
amount being added, and [SUM TOTAL] is used to display the resulting figure, which is the 
Net Earnings for the report.

Outstanding balance5.	

To view the total value of balances currently outstanding on all clients’ billing accounts, use 
[SUM UNPAID].
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What tags are available for use on my templates?

The following is a list of the tags available for use on invoice, statement, and report templates. 
Tags are grouped according to the sections in which they are to be used, then arranged alpha-
betically. Each tag includes a basic description of its function and use. For more information 
about using tags and editing templates in general, see How do I get started with template 
editing? (in this chapter). For a description of billing-related tags and how their figures are 
calculated, see How does iBiz calculate its figures during the billing process? (previous section).

NOTE
	 Users of previous iBiz versions will note that tags are now indicated with [brack-

ets] instead of <angular brackets>. The old format will still work in iBiz 4, though 
the new format is preferred. Legacy tags are still supported, although they may 
not be listed here.

General

[DAYS UNTIL DUE]: The default number of days until payment is due (specified in iBiz pref-•	
erences).

[INVOICE DUE DATE]: The due date of the invoice or statement, in long format.•	

[INVOICE NO.]: The estimate/invoice/statement number.•	

[INVOICE SHORT DUE DATE]: The due date of the invoice or statement, in short format.•	

[PAGE NO.]: The number of the current page of the rendered document (only available for •	
HTML templates).
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[TODAY LONG]: The current date, in long format.•	

[TODAY SHORT]: The current date, in short format.•	

[TOTAL PAGES]: The total number of pages of the rendered document (only available for •	
HTML templates).

Report summary

[SUM DEDUCTIONS]: The value of deductions applied to all included clients’ projects.•	

[SUM DISCOUNT]: The value of percentage discounts applied to all included clients’ proj-•	
ects.

[SUM EXPENSE]: The value of expense items in all included clients’ projects.•	

[SUM GROSS]: The value of earnings from all included clients’ projects, including markup •	
but excluding discounts, deductions, taxes, and outstanding balances on the clients’ bill-
ing accounts.

[SUM TAX]: The value of taxes added to all included clients’ projects.•	

[SUM TIME]: The total time, quantity, and mileage for all job events in all clients’ projects •	
(excluding flat rate events).

[SUM TOTAL]: The value of earnings from all included clients’ projects, including markup, •	
discounts, deductions, and taxes, but excluding outstanding balances.

[SUM TTL AFTER DED.]: The value of earnings from all included clients’ projects, including •	
markup, discounts, and deductions, but excluding taxes and outstanding balances on the 
clients’ accounts.
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[SUM TTL AFTER DISCOUNT]: The value of earnings from all included clients’ projects, •	
including markup and discounts, but excluding deductions, taxes, and outstanding bal-
ances on the clients’ accounts.

[SUM UNPAID]: The value of balances outstanding on all included clients’ billing accounts.•	

Statement summary

[BL. FEE PERCENTAGE]: The fee percentage applied to the statement.•	

[BL. INVOICES TOTAL]: The value of all invoices included in the statement.•	

[BL. LATE FEE]: The value of the fee applied to the statement.•	

[BL. OVERDUE INVOICES TOTAL]: The value of all overdue invoices included in the state-•	
ment.

[BL. PAYMENTS TOTAL]: The value of all payments included in the statement.•	

[BL. STATEMENT TOTAL]: The value of all invoices, statements, and payments included in •	
the statement (statement fee excluded).

[BL. TAXES 1 TOTAL]: The value of Tax 1 applied to all invoices included in the statement.•	

[BL. TAXES 2 TOTAL]: The value of Tax 2 applied to all invoices included in the statement.•	

[BL. TOTAL TAX]: The combined value of Tax 1 and Tax 2 applied to all invoices included •	
in the statement.

[BL. TOTAL+FEE]: The value of all invoices, statements, and payments included in the •	
statement, plus the statement fee.
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Clients

[$BEGIN CLIENT LINE]: This tag denotes the beginning of the section where clients will be •	
inserted on the report. It is only necessary if you want to run a report across multiple cli-
ents. Only client-related tags should be used in this section.

[$END CLIENT LINE]: This tag denotes the end of the client section.•	

[CL. DEDUCTIONS]: The value of deductions applied to all of the client’s included projects.•	

[CL. DISCOUNT AMOUNT]: The value of percentage discounts applied to all of the client’s •	
included projects.

[CL. EXPENSE TOTAL]: The value of expense items in all of the client’s included projects.•	

[CL. FINAL BALANCE]: The final balance owed by the client, including earnings, markup, •	
discounts, deductions, and taxes from all included projects in addition to any outstanding 
balance on the client’s account.

[CL. GROSS]: The value of earnings from all of the client’s included projects, including •	
markup but excluding discounts, deductions, taxes, and any outstanding balance on the 
client’s account.

[CL. LAST PAY. DATE]: The date of the last payment received by the client.•	

[CL. LAST PAY. NOTE]: The notes of the last payment received by the client.•	

[CL. LAST PAYMENT]: The amount of the last payment received by the client.•	

[CL. TAX 1 AMOUNT]: The value of Tax 1 applied to all of the client’s included projects.•	

[CL. TAX 2 AMOUNT]: The value of Tax 2 applied to all of the client’s included projects.•	

[CL. TAXABLE]: The value of earnings from all of the client’s included projects (including •	
markup, discounts, and deductions) to which taxes may be applied.
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[CL. TOTAL AMOUNT]: The value of earnings from all of the client’s included projects, •	
including markup, discounts, deductions, and taxes, but excluding any outstanding bal-
ance on the client’s account.

[CL. TOTAL TAX]: The combined value of Tax 1 and Tax 2 applied to all of the client’s •	
included projects.

[CL. TOTAL TIME]: The total time, quantity, and mileage for all job events in the client’s •	
projects (excluding flat rate events).

[CL. TTL AFTER DED.]: The value of earnings from all of the client’s included projects, •	
including markup, discounts, and deductions, but excluding taxes and any outstanding 
balance on the client’s account.

[CL. TTL AFTER DISCOUNT]: The value of earnings from all of the client’s included projects, •	
including markup and discounts, but excluding deductions, taxes, and any outstanding 
balance on the client’s account.

[CL. UNPAID BALANCE]: The value of any outstanding balance (whether debt or deposit) on •	
the client’s billing account.

[CLIENT ADDRESS FULL]: The client’s entire address.•	

[CLIENT CITY]: The city of the client’s address.•	

[CLIENT COMPANY]: The client’s company name.•	

[CLIENT COUNTRY]: The country of the client’s address.•	

[CLIENT EMAIL]: The client’s email address.•	

[CLIENT NAME]: The client’s full name (including first, middle, and last names).•	

[CLIENT PHONE]: The client’s phone number.•	

[CLIENT STATE]: The state of the client’s address.•	
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[CLIENT STREET]: The client’s street address.•	

[CLIENT VAT]: The client’s tax ID number, as specified in a custom “Related Names” field in •	
Address Book labeled as “VAT” or “VAT #”.

[CLIENT ZIP]: The zip or postal code of the client’s address.•	

[PREVIOUS AMOUNT]: The value of [CL. TOTAL AMOUNT] from the client’s last recorded •	
invoice.

Projects

[$BEGIN PROJECT LINE]: This tag denotes the beginning of the section where projects will •	
be inserted on the invoice or report. It is only necessary if you want to invoice more than 
one project at a time, or run a report across multiple projects. Only project-related tags 
should be used in this section.

[$END PROJECT LINE]: This tag denotes the end of the project section.•	

[DEDUCTIONS TOTAL]: The value of deductions applied to the project.•	

[DISCOUNT AMOUNT]: The value of the percentage discount applied to the project.•	

[DISCOUNT]: The rate of the percentage discount applied to the project.•	

[EXPENSES TOTAL]: The value of all expense items in the project.•	

[FINAL BALANCE]: The final balance owed by the client, including earnings, markup, dis-•	
counts, deductions, and taxes for the project in addition to any outstanding balance on the 
client’s account.

[FR TOTAL]: The value of earnings from all flat rate job events in the project.•	
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[GROSS TOTAL]: The value of earnings from the project, including markup but excluding •	
discounts, deductions, taxes, and any outstanding balance on the client’s account.

[NON-BILLABLE TIME]: The total time, quantity, and mileage for all non-billable job events •	
in the project (excluding flat rate events).

[NON-BILLABLE TOTAL]: The value of all non-billable job events in the project.•	

[NON-FR TOTAL]: The value of earnings from all timed, quantity-based, and mileage-•	
based job events in the project.

[PREVIOUS AMOUNT]: The value of [CL. TOTAL AMOUNT] from the client’s last recorded •	
invoice.

[PROJECT END DATE]: The project’s due date, in long format.•	

[PROJECT NAME]: The project’s name.•	

[PROJECT NO.]: The project’s number.•	

[PROJECT NOTES]: The project’s notes.•	

[PROJECT SHORT END DATE]: The project’s due date, in short format.•	

[PROJECT SHORT START DATE]: The project’s start date, in short format.•	

[PROJECT START DATE]: The project’s start date, in long format.•	

[TAX 1 AMOUNT]: The value of Tax 1 applied to the project.•	

[TAX 2 AMOUNT]: The value of Tax 2 applied to the project.•	

[TAXABLE AMOUNT]: The value of earnings from the project (including markup, discounts, •	
and deductions) to which taxes may be applied.

[TIMED EMPLOYEES]: A list of the names of all employees who appear in timer logs associ-•	
ated with job events in the project.
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[TOTAL AMOUNT]: The value of earnings from the project, including markup, discounts, •	
deductions, and taxes, but excluding any outstanding balance on the client’s account.

[TOTAL TAX]: The combined value of Tax 1 and Tax 2 applied to the project.•	

[TOTAL TIME]: The total time, quantity, and mileage for all job events in the project (ex-•	
cluding flat rate events).

[TTL AFTER DED.]: The value of earnings from the project, including markup, discounts, •	
and deductions, but excluding taxes and any outstanding balance on the client’s account.

[TTL AFTER DISCOUNT]: The value of earnings from the project, including markup and •	
discounts, but excluding deductions, taxes, and any outstanding balance on the client’s 
account.

[UNPAID BALANCE]: The value of any outstanding balance (whether debt or deposit) on the •	
client’s billing account.

Job events

[$BEGIN EXPENSE LINE]: This tag denotes the beginning of the section where job events •	
flagged as expenses will be inserted on the invoice or report. Only job event-related tags 
should be used in this section. When this section is included, expense items will not ap-
pear in the main job event section.

[$BEGIN FLAT RATE LINE]: This tag denotes the beginning of the section where flat rate job •	
events will be inserted on the invoice or report. Only job event-related tags should be used 
in this section. When this section is included, flat rate job events will not appear in the 
main job event section.
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[$BEGIN JOB EVENT LINE]: This tag denotes the beginning of the section where all job •	
events will be inserted on the invoice or report. Only job event-related tags should be used 
in this section.

[$BEGIN NONBILLABLE LINE]: This tag denotes the beginning of the section where flat rate •	
job events flagged as non-billable items will be inserted on the invoice or report. Only job 
event-related tags should be used in this section. Non-billable job events will not appear 
on invoices or reports unless this section is included.

[$END EXPENSE LINE]: This tag denotes the end of the expense section.•	

[$END FLAT RATE LINE]: This tag denotes the end of the flat rate event section.•	

[$END JOB EVENT LINE]: This tag denotes the end of the job event section.•	

[$END NONBILLABLE LINE]: This tag denotes the end of the non-billable event section.•	

[DATE]: The start date of the job event.•	

[FEE]: The job event’s earnings (or cost), based on its time/quantity/mileage and rate (in-•	
cluding markup but excluding discounts and taxes).

[NAME]: The name of the job event.•	

[NOTES]: The job event’s notes.•	

[QUANTITY]: The job event’s quantity or mileage.•	

[RATE]: The job event’s rate.•	

[SSTIME]: The job event’s start and end times.•	

[TIME]: The job event’s time (in standard or decimal format, as specified in iBiz prefer-•	
ences), mileage or quantity.
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Billing activities (client-level)

[$BEGIN ACCOUNT ACTIVITY LINE]: This tag denotes the beginning of the section where •	
items from the client’s billing account (invoices, payments, and statements) will be in-
serted on the statement. Only billing-related tags should be used in this section.

[$BEGIN OVERDUE INVOICES LINE]: This tag denotes the beginning of the section where •	
overdue invoices from the client’s billing account will be inserted on the statement. Only 
billing-related tags should be used in this section.

[$END ACCOUNT ACTIVITY LINE]: This tag denotes the end of the account activity section.•	

[$END OVERDUE INVOICES LINE]: This tag denotes the end of the overdue invoices section.•	

[AMOUNT]: The amount of the billing item.•	

[DATE]: The date the billing item was created.•	

[NO]: The number assigned to the billing item.•	

[NOTES]: Any notes associated with the billing item.•	

[RUN BAL]: The (running) balance of the statement after the billing item’s amount has been •	
added or deducted.

[STATUS]: The status of the billing item (paid, open, overdue, or canceled).•	

[TAX 1]: The value of Tax 1 applied to the (invoice) item.•	

[TAX 2]: The value of Tax 2 applied to the (invoice) item.•	

[TOTAL TAX]: The combined value of Tax 1 and Tax 2 applied to the (invoice) item.•	

[TYPE]: The type of billing item (invoice, payment, or statement).•	
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Employees (project-level)

[$BEGIN EMPL. LINE]: This tag denotes the beginning of the section where information •	
about employee contributions to the project will be inserted on the invoice or report. Only 
employee-related tags should be used in this section. This section must be located within 
the project section.

[$END EMPL. LINE]: This tag denotes the end of the section where information about •	
employee contributions to the project will be inserted on the invoice or report. Only 
employee-related tags should be used in this section. This section must be located within 
the project section.

[EMP AVG. RATE]: The employee’s average hourly rate, based on the job events in the proj-•	
ect for which the employee recorded time in timer logs.

[EMP. COST]: The total cost for the employee, based on his/her recorded time (in timer •	
logs) and the associated job event rates.

[EMP. NAME]: The employee’s name.•	

[EMP. TIME]: The total time which the employee recorded in timer logs associated with •	
timed job events in the project.

Employee logs (job event-level)

[$BEGIN EMPL. LOG LINE]: This tag denotes the beginning of the section where informa-•	
tion about the job event’s timer log will be inserted on the invoice or report. Only timer 
log-related tags should be used in this section. This section must be located within the job 
event section.
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[$END EMPL. LOG LINE]: This tag denotes the end of the section where information about •	
the job event’s timer log will be inserted on the invoice or report. Only timer log-related 
tags should be used in this section. This section must be located within the job event sec-
tion. 

[EMP. NAME]: The employee’s name associated with the timer log entry.•	

[END]: The end date and time of the timer log entry.•	

[START]: The start date and time of the timer log entry.•	
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What is networking iBiz all about?

iBiz Professional allows you to share your iBiz data over a local network or IP connection so 
that multiple users can view and edit the same clients, projects, job events, and billing ac-
counts. iBiz Pro has two main components: iBiz Server acts as a “middle-man” to allow users 
running iBiz Client on other computers, connected through a network, to access project infor-
mation stored on the computer running iBiz Server.
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Rather than having one person track all the work your office performs, each employee can 
enter his or her own time individually on an iBiz Pro network. Several tools are also included to 
facilitate greater collaboration on projects.

Networking requires that you purchase the iBiz Professional package. Visit our online order 
page for more details: https://secure.iggsoftware.com/store

Network capacity

There is no established limit to the number of users that can share data over an iBiz Pro net-
work.

https://secure.iggsoftware.com/store/
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How do I set up an iBiz Pro network? (iBiz Pro only)

Install  iBiz Server on the computer from which you wish to administer the server, and 
install a copy of  iBiz Client on the computer of each user you want to have access to the 
iBiz network. If you have a firewall installed on the server computer or on your router, you may 
need to open ports 5345 through 5351.

Be sure to keep the iBiz Server application open whenever you want the iBiz network to be ac-
cessible, as iBiz Client users can only access the server when it is running.

NOTE
	 Project and job event information can only be added or changed via iBiz Client. 

If you want to be able to make these changes from the computer running iBiz 
Server, be sure to install a copy of iBiz Client on that computer as well.

Upgrading from previous versions

If you are upgrading from iBiz Server/Client 2.x or 3.x, all of your client and project data will 
be imported by the Setup Assistant the first time you run iBiz Client 4. To ensure that the con-
version goes as smoothly as possible, please follow these steps:
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Before installing anything, read the file titled “Important Upgrade Info” that is included in 1.	
the iBiz Professional download. Particularly if you are upgrading from iBiz 2.x, there are 
important preparations you need to make with that version before upgrading.

Backu2.	 p your iBiz data.

Install iBiz Server 4 and iBiz Client 4 on the Mac that ran the old version of iBiz Server.3.	

Launch iBiz Server 4, then launch iBiz Client 4 and complete the 4.	 Setup Assistant. Failure to 
complete this step may result in your data not upgrading properly, so be sure to finish it!
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How do I see who is currently connected to the 
server? (iBiz Pro only)

To view a list of connected users, make sure the main iBiz Server window is open, then choose 
Server > Connected Users or click the  Users button on the toolbar. A drawer will appear 
to the left or right side of the window, depending on where there is more space available, 
displaying the names of all iBiz Client users with an active connection to iBiz Server.
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The user name for each iBiz Client user is determined automatically based on the Mac OS X 
login name under which that copy of iBiz Client is being run. More than one iBiz Client user 
may share the same login name (on different computers) and still be allowed to connect to iBiz 
Server.
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How do I manage clients in iBiz Server? (iBiz Pro only)

Clients are managed in iBiz Server much the same way as in the stand-alone version of iBiz. 
When you open iBiz Server, you should be presented with a window showing your client list.
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Adding, editing, and deleting clients

Use the  and  buttons at the bottom of the client list to add and remove clients, re-

spectively. Select a client and click the  Edit Client button on the toolbar to edit the cli-
ent’s contact info with Address Book. Choose Client > Add Client Group to add client groups. 
For more detailed information about adding/editing/deleting clients, please see Chapter 2: 
Clients.

Sharing clients over the network

Click the checkbox next to a client displayed in the list to determine whether or not it can be 
accessed by connected users. Checked items are available for iBiz Client users for viewing, 
editing, and project creation; unchecked  items are not. The  All Clients item can be 
shared or hidden from users in the same manner.

Changing how clients are displayed

Choose iBiz Server > Preferences and click the  Clients button. Here you can choose how 
clients are displayed in iBiz Server. This setting will not affect how connected users view their 
clients; the same setting can be set individually in iBiz Client.
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Can multiple users work on a project 
simultaneously? (iBiz Pro only)

The iBiz Professional package allows multiple users to work on projects simultaneously. All 
connected users can make modifications to the same project; the changes will be updated on 
the server in real-time and made available to the other users almost immediately.

Two users cannot, however, log time on the same job event simultaneously. When one user is 
timing an event while connected to the network, other users will see a gray clock  next to the 
job event in iBiz Client and will not be allowed to modify it. Once the first user finishes timing 
the job event, it will become available for other users to edit (or another user to begin timing).

 TIP
	 If an iBiz Client user disconnects unexpectedly while a timer is running on a job 

event, it may get “stuck.” To force a timer to start or stop under these circum-
stances, Control-click on the job event and choose “Force Start/Stop Timer” from 
the contextual menu.

To change how project numbers are incremented:

In iBiz Server, choose iBiz Server > Preferences and click the  Clients button. Here you can 
choose whether new projects created by connected users are assigned incrementing numbers 
globally or for each client.
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How do I share custom job events over the 
network? (iBiz Pro only)

In iBiz Server, click the  Administration button on the toolbar to open the admin window. 
Click the  Job Events button and check “Connected users use job events on server.”
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When this option is enabled, all iBiz Client users see the same set of custom job events. They 
cannot edit these events or add their own; the custom job events can only be administered 
from iBiz Server. Disabling this option will allow each user to keep his or her own custom job 
events.

Managing custom job events on the server

Use the  and  buttons at the bottom of the list to add and remove custom job events, 
respectively. Use the fields to the right side to enter and edit the job event details. After mak-
ing changes to custom job events, click “Update Connected Users” to ensure that all iBiz Client 
users see the changes immediately.

Any event in the list with a check next to its name will be made available to connected us-
ers running iBiz Client (as long as “Connected users use job events on server” is checked). For 
more information about editing custom job events, see What are custom job events? in Chapter 
4: Job Events.
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How do I share To Do items over the network? 

(iBiz Pro only)

In iBiz Server, click the  Administration button on the toolbar to open the admin window. 
Click the  To Dos button.
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Managing To Do items on the server

Here you can view and edit To Do items entered under your clients and projects. Select a client 
in the main iBiz Server window to view its associated projects in the admin window, then select 
a project to view and edit its associated To Do items.

Use the  and  at the bottom of the To Do list to add and remove items, respectively. 
Double-click a To Do item to change its name, or double-click in the “Assigned To” column if 
you want to enter the name of the person who is expected to complete the task (all iBiz Client 
users will see this information). Click the priority icon to change a To Do item’s priority, or 
check it off to mark it complete.

To assign a due date to an item, select it and check “Due date” at the bottom of the list. Type 
in the appropriate due date in the box to the right. A gray exclamation image  appears next 
to a To Do item when it is overdue.

Preventing users from editing To Do items

Check “Prevent connected users from editing To Do items.” When this option is enabled, con-
nected users will all see the same To Do items. They will not be permitted to edit these or add 
their own; the To Do items can only be administered from iBiz Server. Disabling this option will 
allow each user to keep his or her own To Do items.
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 TIP
	 Use To Do items to delegate work on a project! Enter names in the “Assigned To” 

field of each To Do item, then prevent editing so that your employees can check 
off items as they are completed, but cannot change their details.
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How do I manage network user permissions? 

(iBiz Pro only)

iBiz Pro includes the option to restrict access to certain program features on a per-user basis. 
These permissions are configured in iBiz Server, then applied automatically to each iBiz Client 
user when he or she connects to the server.

Configuring permissions

In iBiz Server, click the  Administration button on the toolbar to open the admin window. 

Click the the  Permissions button to view the list of users for whom permissions have 
been restricted.

Click the  button at the bottom of the user list to add a new user, then double-click it to 
type in the name of the user whose permissions you want to edit. Use the list of connected 
users to check which names can be entered. Once a user has been added to the list, you can 
restrict his or her access to the following features by checking the item(s) you want to restrict.
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Under the “Visibility” tab, check the appropriate boxes to prevent the selected user from view-
ing any of the following:

Client billing are•	 a

Client balance•	 s

Project earning•	 s

Project balance•	 s

Project estimate•	 s

Job event rate•	 s

Job event earning•	 s

Under the “Actions” tab, check the appropriate boxes to prevent the selected user from doing 
any of the following:

Creating invoice•	 s

Creating estimate•	 s

Creating report•	 s

Creating client•	 s

Deleting client•	 s

Creating project•	 s

Deleting project•	 s

Deleting job event•	 s

Checking out from iBiz Serve•	 r
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NOTE
	 Users who are permitted to checkout from iBiz Server will maintain their other 

permission settings while working offline. 

Each user can be assigned unique permissions. After adjusting these settings, click “Apply” to 
ensure that the changes take effect immediately.

Restricting guest access

To prevent users that do not appear in the list from accessing iBiz Server, check “Only allow 
these users to connect.” Any iBiz Client user that is not listed in the iBiz Server permissions 
window will not be permitted to establish a connection with the server. When this option is 
unchecked, users who do not have permissions explicitly assigned to them will be allowed full 
access to program features.

Removing users from the permissions list

To delete a user from the list and remove all his/her associated restrictions, select the user and 
click the  button.
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How do I assign group rates for work performed? 

(iBiz Pro only)

Group rates allow you to set up different billing rates for your employees and then easily as-
sign those rates on a per-client or per-project basis.

Each group rate can assign a single default rate to several employees. Any client or project can 
then be assigned one of your group rates, so when a particular employee works on that client 
or project, the employee is given the default rate from the group rate that was assigned for 
him/her for that client/project.

For example, you could create a “premium rate” group for which Employee #1 bills at $75/
hr and Employee #2 bills at $100/hr. You could then assign the “premium rate” to Client XYZ: 
whenever Employee #1 or #2 works for Client XYZ, their job events would take on the appro-
priate rates ($75 and $100, respectively).

Enabling group rates

In iBiz Server, click the  Administration to open the admin window. Click the  Rates 
button, then check “Use group rates for clients and projects.”
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When this option is enabled, group rates are applied as default rates to job events created by 
the specified users. These rates take precedence over custom job event rates, project fixed 
rates, and global rates. Group rates are not set in stone, however: iBiz Client users can always 
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change their job event rates from the defaults (provided they have permission to do so), even 
when a group rate has been applied. Disabling “Use group rates for clients and projects” will 
give priority back to individual users’ default rate settings.

Configuring group rates

Make sure the “Manage” tab is selected. Click the  button below the “Group Rate” list to 
create a new group rate, then double-click the item to give it a name to help distinguish it 
from the other rates. With the group rate selected, click the  button below the “User Name” 
list to add iBiz Client users to the group rate. Double-click the user’s name and rate to set 
them appropriately (refer to the list of connected users to check which names can be entered). 
Use the  buttons to remove group rates and users from their respective lists.

 TIP
	 Use “Make Default” to designate a group rate for use across the board. Select the 

group rate and click “Make Default” - it will be applied to all new job events cre-
ated (for all projects and clients), unless a different group rate has been specified. 
The default group rate appears in bold text. To remove the default setting, select 
the default group rate and click “Make Default” a second time.

Applying group rates

Once you have configured the different group rates, you must apply them to your clients and/
or projects in order for them to take effect. Click the “Assign” tab, then select a client on the 
left side of the window to view its associated projects on the right side.
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Click in the “Group Rate” column next to any client or project to view a drop-down list of the 
available group rates. Choose one to assign it to the chosen client/project. Assigning a group 
rate to a client will cause job events created in all of that client’s projects to be assigned the 
rates indicated by the specified group rate. Projects only need to be assigned group rates if 
you want them to use different group rates than those assigned to their clients.

To remove a group rate from a client/project, select the client or project and click the “- Client 
Group Rate” or “- Project Group Rate” button, respectively. Clients and projects with no group 
rate assigned will not have their job event rates changed unless a default group rate has been 
specified (see above).
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How do I use iBiz Client? (iBiz Pro only)

With only a few exceptions, iBiz Client works exactly the same as the stand-alone version of 
iBiz. When iBiz Client users are connected to iBiz Server, they all see the same clients, projects, 
job events, billing accounts, and related information. Changes made by any one user are im-
mediately saved to iBiz Server and seen by other iBiz Client users. This allows real-time col-
laboration between users on an iBiz Professional network.

The biggest difference between iBiz Client and the stand-alone version of iBiz is that iBiz Client 
must either be running on the same local area network as iBiz Server, or connected remotely 
via IP, in order to view and edit project information (unless you checkout from the server). If 
iBiz Server is not running or there is a network error, iBiz Client will not display any client or 
project data when it starts up.

Server connectivity

At the top of the iBiz Client window, to the far right side of the title bar, you will find a small 
icon that indicates your connection status:

•	  Connected: iBiz data is being presented directly from iBiz Server and any changes will 
be made in real time over the network.

•	  Disconnected: iBiz data is not available. A connection to iBiz Server must be estab-
lished before you can access the iBiz data.

•	  Checked out: iBiz data is cached on the local computer and available for offline edit-
ing. Don’t forget to synchronize with iBiz Server as soon as you are able to reconnect!
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If iBiz Client is on the same local area network as iBiz Server, it should connect automatically 
when you open the program. If it does not, or if you are connecting remotely, click the 

 Connect button on the toolbar to establish a connection. If iBiz Client is unable to con-
nect to the server, see iBiz Client won’t connect to the server. What’s wrong? in Chapter 10: 
Frequently Asked Questions for troubleshooting steps. To disconnect from iBiz Server, click  

 Disconnect on the toolbar.

NOTE
	 Each copy of iBiz Client on your network must be registered with a unique license 

code. If two copies of iBiz Client with the same registration attempt to connect to 
iBiz Server, they will both be disconnected automatically.

Shared items

iBiz Server can allow custom job events and To Do items to be shared among connected users. 
When these are being shared, you will see the same custom job events and/or To Do items as 
all other iBiz Client users. These are administered centrally from iBiz Server; when enabled, 
these cannot be modified in iBiz Client.

The templates used for generating estimates, invoices, statements, and reports are stored 
centrally on iBiz Server. Any changes made by an iBiz Client user will affect the same templates 
used by all connected users; users cannot create or edit templates solely for individual use.

Additionally, the iBiz Server administrator may assign group rates to users for certain clients or 
projects, so that when you create a job event in those clients/projects, a default rate will auto-
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matically be applied. This rate is not locked, however: as long as you have permission to edit 
job events, you can change it as necessary.

Client restrictions

Along with allowing users to share their iBiz data, iBiz Server permits the administrator to 
restrict individual iBiz Client users’ access to that data. Depending on how your iBiz network 
has been configured, you may not be able to view certain client/project/job event information, 
or billing accounts. You may also be prohibited from creating invoices, estimates, or reports; 
creating or deleting clients or projects; deleting job events; or checking out from iBiz Server.
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How do I restrict user access with a password? 

(iBiz Pro only)

To require iBiz Client users to enter a username and password before connecting to iBiz Server, 

open iBiz Server and choose iBiz Server > Preferences. Click the  Network button, check 
“Require username and password to connect to iBiz Server,” and enter a username and pass-
word (these can be anything you like, as long as you can remember them). When iBiz Client 
users attempt to connect, they will be prompted to enter these; if the username and password 
provided do not match those specified in iBiz Server, the user will not be allowed to connect to 
the server.

NOTE
	 All iBiz Client users share the same username and password when connecting to 

iBiz Server; it is not possible to set up different logins for different users on your 
iBiz Professional network.
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How do I access iBiz Server remotely? (iBiz Pro only)

iBiz Pro does not require that all iBiz Client users be part of the same local area network (LAN) 
in order to connect to iBiz Server. Users may also connect their computers to the server re-
motely via IP. No special configuration is required in iBiz Server to allow remote access; only 
iBiz Client and your office router must be configured appropriately.

Configuring your office router

If the computer running iBiz Server sits behind a router, it is important to make sure that two 
components are properly configured to allow remote access from iBiz Client:

Firewall:•	  If the router has a firewall set up (as most do), you will need to open ports 5345-
5351 (TCP only). This is the range of ports iBiz Server is allowed to use for network con-
nections.

Port forwarding:•	  You will also need to forward the same range of ports (5345-5351) 
to the computer running iBiz Server, so that any traffic on those ports is directed to iBiz 
Server. This typically requires that the computer running iBiz Server be assigned a static IP 
on the local network.

NOTE
	 Each router has its own procedure for configuring these options. For assistance 

with changing the firewall and port forwarding settings, please refer to your 
router’s manual and/or consult with your network administrator.
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Configuring iBiz Client

Once you have your router properly configured to allow access to iBiz Server, open iBiz Client, 

choose iBiz Client > Preferences, and click the  Network button to access the following 
options:

Connect to remote server:•	  Check this option to enable remote access via IP. Enabling 
remote access will prevent iBiz Client from connecting to iBiz Server when your computer 
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is connected to the same local area network as the server, so be sure to disable this option 
if you reconnect to the LAN.

IP Address: •	 Enter the IP address of your office router here, so that iBiz Client can at-
tempt to establish a connection with the server (if the server’s IP address begins with 
“192.168...”, it is most likely connected through a router). If you do not have a router, 
enter the IP address of the computer running iBiz Server. If you do not know the IP address 
of your router or server, your network administrator can provide it.

Port:•	  Enter the port number currently being used by iBiz Server. To locate this number, 

open iBiz Server, choose iBiz Server > Preferences, click the  Network button, and 
look under “Current Connection Info.”

Connecting to iBiz Server

After the router and iBiz Client have been properly configured for remote access, iBiz Client will 
automatically connect to the server when you launch it. If iBiz Client fails to connect automati-

cally, click the  Connect button on the toolbar to try again. If iBiz Client is still unable to 
connect to the server, see iBiz Client won’t connect to the server. What’s wrong? in Chapter 10: 
Frequently Asked Questions for troubleshooting steps.

NOTE
	 After connecting to iBiz Server, you can view your connection settings under the 

“Network” tab in iBiz Client > Preferences (look for “Current Connection Info”). 
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Disconnecting from iBiz Server

When you are connected to the server, the toolbar button will change from “Connect” to “Dis-

connect.” Click the  Disconnect button to disconnect from iBiz Server. To disable remote 
access and connect to a server on the local network, choose iBiz Client > Preferences, click the 

 Network button, and uncheck “Connect to remote server.”
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How do I work on projects while disconnected 
from iBiz Server? (iBiz Pro only)

To perform work while disconnected from the server, iBiz Client users can “checkout” clients 
and their projects, and synchronize any changes when they reconnect to iBiz Server. Billing 
accounts cannot be modified while working offline.

Checking out from iBiz Server

In iBiz Client, Command-click in the client list to select the clients whose projects you want 
to checkout (or select  All Clients to be able to choose any projects), then choose File > 
Checkout From Server. In the window that appears, check off the project(s) you want to check-
out (or check a client to check out all projects associated with that client) and click “Checkout.” 
You can then disconnect from the network, take your projects on the road and make changes.

NOTE
	 Checking out from iBiz Server requires permission from the server. See How do I 

manage network user permissions? (in this chapter) for more information. 

When you checkout from iBiz Server, iBiz Client will make a copy of all of the clients and their 
associated projects on your local computer. Until iBiz Client is synchronized with iBiz Server, 
all changes made to a project will be saved locally. Invoices and estimates cannot be generated 
while checked out from the server, nor can you make changes in your clients’ billing accounts. 
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Clients and projects that have been checked out will still be available for other network users 
to make changes to.

Synchronizing changes

To synchronize your changes with iBiz Server after working offline, reconnect your computer to 
the network where iBiz Server is running, open iBiz Client, and choose File > Synchronize With 
Server. iBiz Client will compare the last date and time each job event was edited with informa-
tion stored on iBiz Server to determine which change was made most recently. Both your data 
and the data on the server will be updated to reflect the most recent changes.

NOTE
	 Only changes made to a project by adding/deleting or editing job events, and 

adding/deleting To Do items can by synchronized with iBiz Server. That is, 
changes made to a project’s name, start date or notes, for example, will not be 
transferred to iBiz Server when synchronizing.

If there is a conflict between job events during synchronization (i.e. a job event that you modi-
fied offline was also changed on the network), a window will appear asking you to choose 
which version of the job event should be used. Click on the table with the correct version and 
click the “Accept” button.

Once synchronization is complete, the data shown in iBiz Client will reflect that stored on the 
server, and live editing will resume. Any further changes you make to your iBiz data will be 
shared over the network in real time.
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FAQ Index

iBiz users often write to us with the following questions. Check here first to see if someone 
else has already asked your question!  The following sections make up this chapter:

Updating, upgrading, installing, & registering… ………………………………………………289
How do I update iBiz?………………………………………………………………………………………… 289
When will I have to upgrade?… …………………………………………………………………………… 289
I lost my registration code! How can I retrieve it?……………………………………………………… 289
How do I change the code used to register a copy of iBiz?… ……………………………………… 290
Why won’t iBiz accept my registration?… ……………………………………………………………… 290
How do I move my iBiz data to a new computer? … ………………………………………………… 291

Clients and projects… …………………………………………………………………………………293
One of my clients is showing a question mark! How can I fix this?… …………………………… 293
Some of my projects are missing! How can I get them back?… …………………………………… 293
I accidentally deleted a project! How can I get it back?… …………………………………………… 295

Job events and timers… ………………………………………………………………………………296
Why isn’t my Document Monitor working?……………………………………………………………… 296

Billing and templates……………………………………………………………………………………297
How do I add page numbers to my template?… ……………………………………………………… 297
How do I add headers and footers to my template?… ……………………………………………… 297

Networking (iBiz Pro only)… …………………………………………………………………………299
iBiz Client won’t connect to the server. What’s wrong?……………………………………………… 299
Can I encrypt my network data for improved security?… …………………………………………… 300
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Troubleshooting…………………………………………………………………………………………301
iBiz crashed! What do I do next?…………………………………………………………………………… 301

Other questions… ………………………………………………………………………………………302
How does iBiz integrate with iBank?……………………………………………………………………… 302
Can I use Applescript or Automator with iBiz?… ……………………………………………………… 302

If you still can’t find the answer to your question, check our online forums or email customer 
support for assistance (see Chapter 11: Contact Us for more information).
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Updating, upgrading, installing, & registering

How do I update iBiz?

Our development team is constantly working to make iBiz a better application; as a result, 
updates are frequently made available for download from our website. As long as the main 
version number matches the one you purchased, it is free to install - your original registration 
code will be automatically recognized. That means if you purchased iBiz 4, v4.01, v4.1, v4.25, 
etc. are all free to you! Check the following page frequently to stay up-to-date: http://www.
iggsoftware.com/ibiz.

When will I have to upgrade?

Each major version of iBiz released is considered to be a paid upgrade; that is, if you pur-
chased iBiz 4 and we release iBiz 5, you will have to pay an additional fee to upgrade. Our 
promise to you is that we will not release major versions less than one year apart. Additionally, 
we frequently offer reduced pricing for upgrading users of previous versions. Visit our order 
page for more details: https://secure.iggsoftware.com/store.

I lost my registration code! How can I retrieve it?

If you lost the license code you obtained when you purchased iBiz, please try to retrieve it us-
ing the “Lost License” form on our website: http://www.iggsoftware.com/support.php.

http://www.iggsoftware.com/ibiz
http://www.iggsoftware.com/ibiz
https://secure.iggsoftware.com/store/
http://www.iggsoftware.com/support
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If you can’t retrieve your code using that form, please contact us and we will be happy to assist 
you.

How do I change the code used to register a copy of iBiz?

To “un-register” a copy of iBiz, delete the appropriate preferences file:

iBiz (stand-alone version): /Users/•	 yourUserName/Library/Preferences/com.iggsoftware.
iBiz.plist

iBiz Client: /Users/•	 yourUserName/Library/Preferences/com.iggsoftware.iBizClient.plist

iBiz Server: /Users/•	 yourUserName/Library/Preferences/com.iggsoftware.iBizServer.plist

The next time you start iBiz, you will be asked to register again. Some basic program settings 
will also need to be reconfigured, including those specified in the Setup Assistant and those 
found in iBiz > Preferences.

Why won’t iBiz accept my registration?

First, make sure you installed the correct version of the software. If you purchased a license 
for iBiz 3 and installed version 4, it will not accept your code. Once you are sure you have the 
correct version of iBiz installed, read on.

iBiz is very picky about how you enter your registration information. You must type your name, 
email address, and license code exactly as they appear in the confirmation email you received 
after ordering the software. iBiz uses both your name and email address to verify the license 
code, so be precise.
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Pay attention to uppercase/lowercase letters, spaces, punctuation, and special characters.•	

Be careful to distinguish between the capital letter ‘O’ and the number ‘0’.•	

Some non-Latin characters may cause problems with iBiz’s registration algorithm. If you •	
have any of these characters in your name or email address then please contact us.

Additional information:

For more information about registering iBiz, see How do I purchase and/or register iBiz? in 
Chapter 1: Getting Started.

How do I move my iBiz data to a new computer?

When changing computers, there are several files that should be copied over to ensure that iBiz 
makes the transition smoothly:

iBiz (stand-alone version):

/Applications/iBiz (the iBiz application)•	

/Users/•	 yourUserName/Library/Application Support/IGG Software/iBiz/ (iBiz data files)

/Users/•	 yourUserName/Library/Application Support/AddressBook/ (Address Book data)

/Users/•	 yourUserName/Library/Calendars/ (iCal calendars)

/Users/•	 yourUserName/Library/Preferences/com.iggsoftware.iBiz.plist (iBiz preferences and 
registration)
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iBiz Server:

/Applications/iBiz Server (the server application)•	

/Users/•	 yourUserName/Library/Application Support/IGG Software/iBiz/ (iBiz Server data 
files)

/Users/•	 yourUserName/Library/Application Support/AddressBook/ (Address Book data)

/Users/•	 yourUserName/Library/Calendars/ (iCal calendars)

/Users/•	 yourUserName/Library/Preferences/com.iggsoftware.iBizServer.plist (iBiz Server 
preferences and registration)

iBiz Client:

/Applications/iBiz Client (the client application)•	

/Users/•	 yourUserName/Library/Application Support/IGG Software/iBiz/ (iBiz Client data 
files)

/Users/•	 yourUserName/Library/Preferences/com.iggsoftware.iBizClient.plist (iBiz Client 
preferences and registration)

After copying all appropriate files to the new computer, check to be sure that your clients and 
projects are available in iBiz. If you see your clients, but no projects are visible, see Some of 
my projects are missing! How can I get them back? (in this chapter) for help with restoring your 
projects.
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Clients and projects

One of my clients is showing a question mark! How can I fix this?

When a client cannot find its associated  Address Book entry, it will display a question 
mark card  next to its name in iBiz. This will happen if the client is accidentally removed 
from your Address Book, or modified in some way that causes iBiz to lose track of it.

To re-associate the client, first use Address Book to recreate the client’s card. Then select the 
client in iBiz, choose Client > Associate Client to Address Book Person, and select the appro-
priate Address Book entry from the sheet that appears. iBiz will add the contact card back to 
the “iBiz Clients” group in Address Book and the question mark icon will no longer be displayed 
in the iBiz client list.

Some of my projects are missing! How can I get them back?

If you can see all of your clients in the client list, but no projects are visible in the project list, 
don’t panic. First, check the following:

The Projects tab should be selected in the •	 main window. If the Billing tab is selected, you 
will not be able to view your projects.

Make sure your projects are not •	 filtered out: choose Project > Show All Projects.

Make sure you have a client selected that should contain projects. Click •	 “All Clients” to see 
if any projects are present in iBiz.
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After checking these three things, if your projects are still not visible, follow these steps to 
reload your projects into iBiz:

iBiz (stand-alone):

In the Finder, browse to the following folder: /Users/•	 yourUserName/Library/Application 
Support/IGG Software/iBiz/Projects. You should see a bunch of files with long, unintel-
ligible names (each one of these represents a single iBiz project).

Select all of these files, then drag and drop them onto the “All” client in the main iBiz win-•	
dow. The projects should load back into iBiz, ready for editing once again.

You may need to reassign the projects to their appropriate clients by selecting the “All” •	
client to view your projects, then dragging and dropping each one onto the client to which 
it belongs.

iBiz Professional:

On the computer running •	 iBiz Server, browse to the following folder in the Finder: /Users/
yourUserName/Library/Application Support/IGG Software/iBiz/Projects. You should see a 
bunch of files with long, unintelligible names (each one of these represents a single iBiz 
project).

Select all of these files, then drag and drop them onto any client •	 except the “All Clients” 
item in the iBiz Server window. Open iBiz Client to verify that the projects are loaded back 
into iBiz, ready for editing once again.

You may need to reassign the projects to their appropriate clients by opening iBiz Client, •	
selecting the client onto which you dropped your projects, then dragging and dropping 
each project onto the client to which it belongs.
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I accidentally deleted a project! How can I get it back?

Please see How do I recover a deleted project? in Chapter 3: Projects for information on this 
topic.
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Job events and timers

Why isn’t my Document Monitor working?

Document Monitor requires Universal Access to be enabled on your computer. Make sure “En-
able access for assistive devices” is checked under the Unversal Access pane in System Prefer-
ences.
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Billing and templates

How do I add page numbers to my template?

Page numbers are only available for use with HTML templates. To display page numbers, add 
the [PAGE NO.] and [TOTAL PAGES] tags to your template at the summary level (they will not 
work inside any sections).

How do I add headers and footers to my template?

Headers and footers are only available for use with HTML templates. In order to use headers 
and footers, each element directly under the <body> tag in your code must be either a <div> 
or <table> element, and must be designated as part of the header, footer, or body. Any ele-
ments that are not designated as part of one of these sections will not be displayed when the 
document is rendered.

Headers:

To designate a <div> or <table> element for use as a header on every page, add “id=’ibiz_
header_all’” to the tag, e.g. “<div id=’ibiz_header_all’>”. To designate a header for only the 
first page of the rendered document, use “id=’ibiz_header_first’”, and for all pages except the 
first use “id=’ibiz_header_notfirst’.”
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Footers:

To designate a <div> or <table> element for use as a footer on every page, add “id=’ibiz_
footer’” to the tag.

Body elements:

When you use headers and footers, every other element that falls under <body> must be either 
a <div> or <table> element, and must be designated “class=’ibiz_body’.”
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Networking (iBiz Pro only)

iBiz Client won’t connect to the server. What’s wrong?

First, check to make sure that the installed versions of both iBiz Server and iBiz Client are 
exactly the same. Even a slight mismatch between version numbers can cause communica-
tion problems on your iBiz Pro network. For this reason, we encourage that updates are made 
across the network simultaneously. This is the cause of the majority of iBiz network problems. 
If that doesn’t resolve the problem, read on.

Local network users:

iBiz Client must be on the same subnet as iBiz Server; the networking technology used by iBiz 
requires this. iBiz utilizes Bonjour technology to ensure simple, no-hassle network connectiv-
ity.

You can test the network by running iChat and checking to see if Bonjour users can see one 
another - if Bonjour doesn’t work with iChat, then it won’t work with iBiz either. If you have a 
firewall installed on your router, you may need to open ports 5345 through 5351 to allow iBiz 
Client to connect to the server.

If you are on the same network and still can’t connect, or your connection drops frequently, try 
increasing the ping time in iBiz Server (iBiz Server > Preferences, under “Network”).
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Remote users (connected via IP):

Double-check that you have entered the correct IP address to connect to iBiz Server under 
iBiz Client > Preferences and click the “Network” button. The address should not start with 
“192.168...” as this typically indicates an address on a local network. Make sure the port num-
ber falls between 5345 and 5351.

If you have verified these settings and still can’t connect, you may need to check with your 
Internet Service Provider (ISP) or network administrator regarding proxy and/or port forwarding 
settings. If your connection drops frequently, try increasing the ping time in iBiz Server (iBiz 
Server > Preferences, under “Network”).

If you try these things and iBiz Client still can’t connect to the server, please open the Console 
application (found here: /Applications/Utilities/Console), try to establish a connection in iBiz 
Client, then switch back to Console and report any messages you see back to us at IGG Soft-
ware.

Can I encrypt my network data for improved security?

iBiz Server automatically encrypts all of your data, using the Blowfish algorithm, as it is relayed 
to and from iBiz Client. You can rest assured that your data is safe from prying eyes.
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Troubleshooting

iBiz crashed! What do I do next?

In the event of a crash, make note of what you were doing before the crash occurred, recalling 
the exact steps you took leading up to the crash if possible. Send an email to support@iggsoft-
ware.com alerting us to the problem. Please be sure to include the name and version number 
of the program you are using, a detailed description of the problem, and any information that 
might help us to reproduce the crash.

If a crash report is generated, choose the option to view the report, then use copy and paste to 
include it in your email. This information is particularly valuable in helping us to isolate bugs in 
the software.

If a problem occurs frequently, but does not produce a crash report, please open the Console 
application (found here: /Applications/Utilities/Console), cause the problem to repeat, then 
switch back to Console and report any messages you see back to us at IGG Software.

mailto:support@iggsoftware.com
mailto:support@iggsoftware.com
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Other questions

How does iBiz integrate with iBank?

NOTE
	 If you purchased iBiz from the Mac App Store, iBank integration features are not 

available. The information below only applies to the version of iBiz that is avail-
able for download from the IGG Software website.

If you use iBank 3 to manage your finances, you can use iBiz to create transactions from your 

projects and job events. Click the  iBank button on the toolbar and choose “Launch 
iBank” to get started.

Once iBank is open, select a single project, job event, or payment in iBiz (you can only send 

one item at a time), click the  iBank toolbar button, and select the iBank account to which 
you want to add the transaction. By default, job events are added as withdrawals with the job 
event names listed as the transaction payees. Projects and payments are added as deposits 
with the client names listed as the transaction payees.

You can also have iBiz automatically record deposits in iBank when you enter payments - see 
How do I record payments from my clients? in Chapter 6: Billing for more details.

http://www.iggsoftware.com/ibank/downloads.php#older
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Can I use Applescript or Automator with iBiz?

If you are handy with Applescript or Automator, you can write scripts and workflows to 
streamline many repetitive tasks in iBiz, including project creation, invoice delivery, receipt of 
payments, and much more! Feel free to contact technical support for tips on how to better use 
Applescript and Automator to get more out of iBiz.
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Where can I find help or get additional support?

In addition to this manual, we offer free technical assistance via live chat, email, and a com-
munity-driven knowledge base. Please feel free to contact us at any time; we will be sure to 
respond to your inquiry in a timely and effective manner.

To see if other iBiz users have previously discussed a topic that concerns you, please browse 
our knowledge base at: qa.iggsoft.com/ibiz

If you can’t find an answer to your question, please contact us at iggsoftware.com/support for 
assistance.

http://qa.iggsoft.com/ibiz
http://www.iggsoftware.com/support
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